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4
5          Adobe Acrobat Reader 
6
7 Finding Words
8
9 You can use the Find command to find a complete word or part of a word in the current PDF 

10 document.  Acrobat Reader looks for the word by reading every word on every page in the file, 
11 including text in form fields.
12
13 To find a word using the Find command:
14
15 1. Click the Find button (Binoculars), or choose Edit > Find.
16 2. Enter the text to find in the text box.
17 3. Select search options if necessary:
18 Match Whole Word Only finds only occurrences of the complete word you enter in 
19 the box.  For example, if you search for the word stick, the words tick and sticky will 
20 not be highlighted.
21
22 Match Case finds only words that contain exactly the same capitalization you enter in 
23 the box.
24
25 Find Backwards starts the search from the current page and goes backwards through 
26 the document.
27 4. Click Find.  Acrobat Reader finds the next occurrence of the word.
28        
29 To find the next occurrence of the word, Do one of the following:
30            
31             Choose Edit > Find Again 
32             Reopen the find dialog box, and click Find Again. 
33             (The word must already be in the Find text box.)
34
35 Copying and pasting text and graphics to another application
36
37 You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 
38 into another application such as a word processor.  You can also paste text into a PDF 
39 document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 
40 can switch to another application and paste it into another document.  
41
42 Note:  If a font copied from a PDF document is not available on the system displaying the 
43 copied text, the font cannot be preserved.  A default font  is substituted.
44
45
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8 To select and copy it to the clipboard:
9 1. Select the text tool T, and do one of the following:

10        To select a line of text, select the first letter of the sentence or phrase and drag to
11        the last letter.  
12
13 To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 
14 (Mac OS) as you drag across the width of the document. 
15        
16 To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 
17 (Mac OS) as you drag the length of the document.
18         
19 To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 
20 on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 
21 in the document is selected.  When you release the mouse button, the selected text is 
22 highlighted.  To deselect the text and start over, click anywhere outside the selected text.  
23 The Select All command will not select all the text in the document.  A workaround for this 
24 (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 
25 text to the clipboard.
26
27 2. To view the text, choose Window > Show Clipboard
28
29 In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 
30 Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 
31 Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 
32 Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.
33
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1 [REPORT OF ACTION TAKEN IN CLOSED

2 SESSION JUNE 7, 2011 ON PAGE 70.]

3

4

5

6 SUP. ANTONOVICH, MAYOR: THE JUNE 7, 2011, MEETING OF THE LOS 

7 ANGELES COUNTY BOARD OF SUPERVISORS WILL BEGIN. FIRST WE'LL BE 

8 LED IN PRAYER BY PASTOR COREY LOVERS, WHO IS THE SENIOR PASTOR 

9 OF THE ACTON FOURSQUARE CHURCH. THE AUDIENCE WOULD PLEASE 

10 RISE. AND OUR PLEDGE OF ALLEGIANCE WILL BE LED BY DAVID 

11 GALAZYN, VOLUNTEER WITH THE LONG BEACH MEDICAL CLINIC. WOULD 

12 THE AUDIENCE PLEASE RISE. PASTOR LOVERS? 

13

14 PASTOR COREY LOVERS: I'D LIKE TO READ JUST A COUPLE OF VERSES 

15 FROM THE BIBLE. THE BIBLE SIMPLY MEANS BOOKS, AND WITHIN THE 

16 VOLUME HERE, THERE ARE ACTUALLY 66 INDIVIDUAL BOOKS WRITTEN BY 

17 OVER 40 DIFFERENT INDIVIDUALS OVER 1500 YEARS. READING FROM 

18 THE BOOK OF PSALMS, VERSE 1 IT SAYS: MAKE A JOYFUL NOISE UNTO 

19 THE LORD ALL YOU LAND, SERVE THE LORD WITH GLADNESS, COME 

20 BEFORE HIS PRESENCE WITH SINGING. KNOW THAT THE LORD, HE IS 

21 GOD. IT IS HE WHO HAS MADE US AND NOT WE OURSELVES. WE ARE HIS 

22 PEOPLE AND THE SHEEP OF HIS PASTURE. ENTER INTO HIS GATES WITH 

23 THANKSGIVING AND INTO HIS COURTS WITH PRAISE. BE THANKFUL TO 

24 HIM AND BLESS HIS NAME. FOR THE LORD, HE IS GOOD, HIS MERCY IS 

25 EVERLASTING AND HIS TRUTH ENDURES FOR ALL GENERATIONS. THOSE 
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1 OF YOU THAT WOULD LIKE TO MAY BOW YOUR HEADS. HEAVENLY FATHER, 

2 I ASK TODAY THAT YOU WOULD BLESS OUR SUPERVISORS, LORD, THAT 

3 YOUR HAND WOULD BE ON THEM AND KEEP THEM STRONG AND HEALTHY. 

4 LORD, I PRAY THAT YOU WOULD PROTECT THEIR FAMILIES AND 

5 THEMSELVES FROM ACCIDENT, FROM INJURY. LORD, WE ASK YOUR 

6 BLESSING ON THIS MEETING TODAY, THAT YOU WOULD OVERSHADOW, 

7 THAT YOU WOULD OVERSEE, THAT YOU WOULD GIVE SUPERNATURAL 

8 WISDOM FOR THE DECISIONS THAT THEY MAKE. I THANK YOU FOR ALL 

9 THIS, AMEN. 

10

11 DAVID F. GALAZYN: PLEASE FACE THE FLAG. PLEASE PUT YOUR RIGHT 

12 HAND OVER YOUR HEART AND JOIN ME IN THE PLEDGE OF ALLEGIANCE. 

13 [PLEDGE OF ALLEGIANCE RECITED.] 

14

15 SUP. ANTONOVICH, MAYOR: PASTOR COREY LOVERS IS FROM ACTON, 

16 WHERE HE IS THE PASTOR, SENIOR PASTOR OF THE FOURSQUARE 

17 CHURCH, WHICH HE BECAME IN 2007. HE'S A NATIVE OF WHITTIER AND 

18 HAS LIVED IN THE COUNTY MOST OF HIS LIFE. HE'S ALSO SERVED 

19 WITH THE LOS ANGELES COUNTY FIRE DEPARTMENT. IN 1983 HE BECAME 

20 A LOS ANGELES COUNTY FIREFIGHTER AND SERVED AS THEIR CHAPLAIN 

21 AND SENIOR CHAPLAIN UNTIL HIS RETIREMENT. AND CURRENTLY HE'S 

22 MARRIED WITH THREE CHILDREN AND HE SERVES AS THE ASSOCIATE 

23 CHAPLAIN TO OUR OWN LOS ANGELES COUNTY FIRE DEPARTMENT. SO 

24 PASTOR LOVERS, THANK YOU VERY MUCH. [APPLAUSE.] SUPERVISOR 

25 KNABE? 
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1

2 SUP. KNABE: MR. MAYOR AND MEMBERS OF THE BOARD, IT'S MY 

3 PLEASURE TO PRESENT A CERTIFICATE OF APPRECIATION TO DAVID 

4 GALAZYN WHO LIVES IN THE CITY OF LONG BEACH AND IS ALSO A 

5 VOLUNTEER AT OUR LONG BEACH MEDICAL CLINIC. HE SERVED IN THE 

6 UNITED STATES ARMY FROM 2000 TO 2004 AS A SPECIALIST IN THE 

7 287TH INFANTRY 10TH MOUNTAIN DIVISION IN AFGHANISTAN. HE 

8 RECEIVED AN ARMY COMMENDATION MEDAL, ARMY GOOD CONDUCT MEDAL, 

9 AND A NATIONAL DEFENSE SERVICE MEDAL, AN AFGHANISTAN CAMPAIGN 

10 MEDAL, AND A GLOBAL WAR ON TERRORISM SERVICE MEDAL. HE IS 

11 MARRIED AND HAS LIVED IN THE FOURTH DISTRICT FOR TWO YEARS. SO 

12 ON BEHALF OF MYSELF AND MY COLLEAGUES AND THE CITIZENS OF THIS 

13 GREAT COUNTY, WE WANT TO SAY THANK YOU FOR ONE, TAKING THE 

14 TIME TO COME DOWN AND LEAD US IN THE PLEDGE, AND TWO, AND MOST 

15 IMPORTANTLY, FOR YOUR SERVICE TO AMERICA. GOD BLESS YOU, MAN. 

16 [APPLAUSE.] 

17

18 SUP. ANTONOVICH, MAYOR: OKAY. WE WILL BEGIN THE AGENDA. 

19

20 CLERK SACHI HAMAI: GOOD MORNING, MR. MAYOR, MEMBERS OF THE 

21 BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 3, AGENDA FOR THE 

22 MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEMS 1-D AND 

23 2-D. ON ITEM NO. 2-D, THERE'S A REQUEST FROM A MEMBER OF THE 

24 PUBLIC TO HOLD THIS ITEM. ITEM 1-D IS BEFORE YOU. 

25
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1 SUP. ANTONOVICH, MAYOR: MOTION BY MOLINA. SECOND WITHOUT 

2 OBJECTION, SO ORDERED. 

3

4 CLERK SACHI HAMAI: ON PAGE 5, AGENDA FOR THE MEETING OF THE 

5 HOUSING AUTHORITY. ON ITEM NO. 1-H, THERE'S A REQUEST FROM A 

6 MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON PAGE 6, BOARD OF 

7 SUPERVISORS ITEMS 1 THROUGH 6. ON ITEM NO. 1, THERE'S A 

8 REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM 

9 NO. 3, THERE'S A -- EXCUSE ME. SUPERVISOR KNABE REQUESTS THAT 

10 THIS ITEM BE HELD. ON ITEM NO. 4, THERE'S A REQUEST FROM A 

11 MEMBER OF THE PUBLIC TO HOLD THE ITEM. AND THE REMAINING ITEMS 

12 UNDER THE BOARD OF SUPERVISORS ARE BEFORE YOU. 

13

14 SUP. ANTONOVICH, MAYOR: OKAY. MOTION BY YAROSLAVSKY. SECOND 

15 WITHOUT OBJECTION, SO ORDERED. 

16

17 CLERK SACHI HAMAI: ON PAGE 9, CONSENT CALENDAR, ITEMS 7 

18 THROUGH 57. ON ITEM NO. 8, THERE'S A REQUEST FROM A MEMBER OF 

19 THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 13, THERE'S A 

20 REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM 

21 NO. 14, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD 

22 THIS ITEM. 

23

24 SUP. KNABE: MADAM EXECUTIVE OFFICER, I'M WILLING TO RELEASE MY 

25 HOLD ON ITEM NO. 3. 
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1

2 CLERK SACHI HAMAI: ON NO. 3? 

3

4 SUP. KNABE: (OFF MIC). 

5

6 CLERK SACHI HAMAI: OKAY. SO WE ARE STILL HOLDING ITEM NO. 3. 

7 BACK TO THE CONSENT CALENDAR, ON ITEM NO. 16, THE CHIEF 

8 EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED ONE 

9 WEEK TO JUNE 14, 2011. 

10

11 SUP. ANTONOVICH, MAYOR: 16. 

12

13 CLERK SACHI HAMAI: 16. ON ITEM NO. 18, AS INDICATED ON THE 

14 SUPPLEMENTAL AGENDA, THE DIRECTOR OF HEALTH SERVICES REQUESTS 

15 THAT THIS ITEM BE CONTINUED ONE WEEK TO JUNE 14, 2011. ON 

16 ITEM, NO. 19, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM 

17 BE CONTINUED ONE WEEK TO JUNE 14, 2011. 

18

19 SUP. KNABE: WHAT ITEM WAS THAT? 

20

21 CLERK SACHI HAMAI: 19. ON ITEM NO. 22, THERE'S A REQUEST FROM 

22 A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 24, THIS 

23 INCLUDES SUPERVISOR MOLINA'S AMENDMENT AS INDICATED ON THE 

24 SUPPLEMENTAL AGENDA AND ALSO SUPERVISOR RIDLEY-THOMAS AND A 

25 MEMBER OF THE PUBLIC REQUEST THAT THIS ITEM BE HELD. 24. ON 
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1 ITEM NO. 25, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO 

2 HOLD THIS ITEM. ON ITEM NO. 26, SUPERVISOR RIDLEY-THOMAS 

3 REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JUNE 14, 

4 2011. ON ITEM NO. 27, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT 

5 THIS ITEM BE CONTINUED ONE WEEK TO JUNE 14, 2011. ON ITEM NO. 

6 30, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS 

7 ITEM. ON ITEM NO. 31, THERE'S A REQUEST FROM A MEMBER OF THE 

8 PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 32, THERE'S A REQUEST 

9 FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 33, 

10 THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS 

11 ITEM. AND ON ITEM NO. 33, SUPERVISOR ANTONOVICH WILL BE 

12 ABSTAINING FROM THE VOTE. ON ITEM NO. 37, THERE'S A REQUEST 

13 FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 40, 

14 THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS 

15 ITEM. ON ITEM NO. 49, AS INDICATED ON THE SUPPLEMENTAL AGENDA, 

16 SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED 

17 TWO WEEKS TO JUNE 21, 2011. ON ITEM NO. 50, AS INDICATED ON 

18 THE SUPPLEMENTAL AGENDA, SUPERVISOR RIDLEY-THOMAS REQUESTS 

19 THAT THIS ITEM BE CONTINUED TWO WEEKS TO JUNE 21, 2011. ON 

20 ITEM NO. 57, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THIS 

21 ITEM IS BEING REINTRODUCED, WAIVE READING AND PLACED ON THE 

22 AGENDA FOR ADOPTION THE ORDINANCE AMENDING THE LOS ANGELES 

23 COUNTY CODE, TITLE 5 PERSONNEL, RELATING THE COUNTY'S SEXUAL 

24 HARASSMENT POLICY. THE REMAINING ITEMS UNDER THE CONSENT 

25 CALENDAR ARE BEFORE YOU. 
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1

2 SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR KNABE. SECOND 

3 WITHOUT OBJECTION, SO ORDERED. 

4

5 CLERK SACHI HAMAI: ON PAGE 36, SEPARATE MATTERS, ITEMS NO. 58 

6 AND 59. AND I JUST NEED TO READ THE SHORT TITLE IN FOR THE 

7 RECORD ON BOTH OF THESE. ITEM NO. 58, THIS IS THE TREASURER 

8 AND TAX COLLECTOR'S RECOMMENDATION TO ADOPT A RESOLUTION 

9 AUTHORIZING THE ISSUANCE OF CERTAIN LOS ANGELES COUNTY SCHOOL 

10 AND COMMUNITY COLLEGE DISTRICTS OF 2011-12 TAX AND REVENUE 

11 ANTICIPATION NOTES AND PROVIDING FOR THE SALE OF PARTICIPATION 

12 CERTIFICATES IN AN AGGREGATE PRINCIPAL AMOUNT NOT TO EXCEED 

13 $165,500,000. THAT ITEM IS BEFORE YOU. 

14

15 SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR MARK RIDLEY-

16 THOMAS. SECOND WITHOUT OBJECTION, SO ORDERED. 

17

18 CLERK SACHI HAMAI: ON ITEM NO. 59, THIS IS THE TREASURER AND 

19 TAX COLLECTOR'S RECOMMENDATION TO ADOPT A RESOLUTION 

20 AUTHORIZING THE ISSUANCE AND SALE OF THE LOS ANGELES UNIFIED 

21 2011-12 TAX AND REVENUE ANTICIPATION NOTES IN AN AGGREGATE 

22 PRINCIPAL AMOUNT NOT TO EXCEED $1,400,000,000. 

23

24 SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR MOLINA. SECONDED 

25 WITHOUT OBJECTION, SO ORDERED. 
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1

2 CLERK SACHI HAMAI: ON PAGE 37, DISCUSSION ITEMS, ITEMS 60 AND 

3 61. ON ITEM NO. 60, SUPERVISOR RIDLEY-THOMAS REQUESTS THAT 

4 THIS ITEM BE CONTINUED THREE WEEKS TO JUNE 28, 2011. 

5

6 SUP. ANTONOVICH, MAYOR: OKAY. MOTION BY SUPERVISOR -- (OFF MIC 

7 COMMENTS). OKAY. 

8

9 CLERK SACHI HAMAI: ON ITEM NO. 61, AS INDICATED ON THE POSTED 

10 AGENDA, IT IS THE INTENTION OF THE BOARD TO PLACE THIS ON THE 

11 FUTURE AGENDAS AS AN "A" ITEM. ITEM NO. 61. THAT WILL BE FROM 

12 NEXT WEEK'S MEETING FORWARD, IT WILL BE PLACED AS AN "A" ITEM. 

13

14 SUP. ANTONOVICH, MAYOR: DOES THAT REQUIRE A VOTE? MOTION BY 

15 YAROSLAVSKY. SECOND WITHOUT OBJECTION, SO ORDERED. 

16

17 SUP. YAROSLAVSKY: ON ITEM 60, I DON'T HAVE A PROBLEM WITH THE 

18 CONTINUANCE, BUT WHEN THEY COME BACK WITH THE REPORT, CAN WE 

19 HAVE THIS REPORT COME BACK JOINTLY FROM THE C.E.O. AND THE 

20 CHIEF DEPUTIES GROUP THAT WAS MEETING BEFORE? 

21

22 SUP. ANTONOVICH, MAYOR: WHAT ITEM? 

23

24 SUP. YAROSLAVSKY: THAT'S 60. 

25
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1 CLERK SACHI HAMAI: 60. 

2

3 SUP. YAROSLAVSKY: 60. AND TO ADDRESS THE ADMINISTRATIVE ISSUES 

4 DEALING WITH THE D.C.F.S. AND PROBATION GOING FORWARD. I 

5 THOUGHT THAT WAS ONE OF THE THINGS WE WANTED. 

6

7 SUP. ANTONOVICH, MAYOR: THAT IS GOING FORWARD. 

8

9 SUP. YAROSLAVSKY: I KNOW. BUT WHEN THEY COME BACK WITH THEIR 

10 REPORT. 

11

12 SUP. ANTONOVICH, MAYOR: OKAY. SUPERVISOR MOLINA? 

13

14 SUP. MOLINA: I WANT TO BE A LITTLE BIT CLEARER. I THINK THAT 

15 WE NEED TO GO BACK TO THE ORIGINAL INTENT OF THE MOTION, WHICH 

16 WAS THAT WE STILL NEED TO HAVE THE COORDINATION OF ALL THE 

17 DEPARTMENTS WHEN IT RELATES TO EACH OTHER, PARTICULARLY IN 

18 CHILDREN'S SERVICES, WHETHER PROBATION AND SO ON. SO WE NEED 

19 TO GO BACK TO THE INTENT AND STILL GET THAT. THAT WAS NOT 

20 ACHIEVED IN THE RECOMMENDATIONS. AND, THEN YEAH, A CLEAR 

21 UNDERSTANDING OF HOW PROBATION AND CHILDREN'S SERVICES ARE 

22 GOING TO CONTINUE UNDER ALL THE PROVISIONS NORMALLY THAT WE'VE 

23 HAD IN C.O., IN CARRYING OUT THE WORK OF THOSE TWO DEPARTMENTS 

24 WITH THE EXCEPTION THAT THE DEPARTMENTS REPORT DIRECTLY TO US. 

25
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1 SUP. ANTONOVICH, MAYOR: THAT'LL BE INCLUDED WHEN IT COMES BACK 

2 IN THREE WEEKS. 

3

4 SUP. MOLINA: THE ADMINISTRATIVE WORK. I HOPE THAT'S CLEAR. 

5

6 SUP. ANTONOVICH, MAYOR: THAT'LL BE INCLUDED WHEN IT COMES BACK 

7 IN THREE WEEKS, THAT INFORMATION. OKAY. MOTION BY MARK RIDLEY-

8 THOMAS, SECOND WITHOUT OBJECTION CONTINUING IT FOR THREE 

9 WEEKS. SO ORDERED. 

10

11 SUP. YAROSLAVSKY: ON NO. 3, I THINK WE CAN DISPOSE OF THAT IF 

12 WE CAN JUST INSERT ONE WORD. TALK ABOUT ADDITIONAL FUNDS? NEW 

13 OR ADDITIONAL FUNDS? IT WAS ALL PART OF RIDLEY-THOMAS'S 

14 MOTION. 

15

16 SUP. MOLINA: THEN YOU STILL WILL ALWAYS HAVE INEQUITY. 

17

18 SUP. YAROSLAVSKY: THEN WE BETTER HOLD IT AND HAVE A DISCUSSION 

19 ABOUT IT. 

20

21 SUP. ANTONOVICH, MAYOR: OKAY MOTION BY MARK RIDLEY-THOMAS, 

22 SECONDED WITHOUT OBJECTION TO RECONSIDER THE ITEM. 

23

24 CLERK SACHI HAMAI: WE WERE HOLDING THE ITEM. WE'RE HOLDING THE 

25 ITEM. 
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1

2 SUP. ANTONOVICH, MAYOR: OKAY. 

3

4 CLERK SACHI HAMAI: SO WE ARE BACK ON PAGE 38, MISCELLANEOUS, 

5 ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS 

6 IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL 

7 AGENDA, ITEM NO. 62-A. 

8

9 SUP. ANTONOVICH, MAYOR: SO MOVED. SECOND BY KNABE. WITHOUT 

10 OBJECTION, SO ORDERED. 

11

12 CLERK SACHI HAMAI: ITEM NO. 62-B, THERE IS AMENDMENT TO THE 

13 SECOND RECOMMENDATION TO AUTHORIZE THE AUDITOR-CONTROLLER 

14 INSTEAD OF THE ACTING DIRECTOR OF CHILDREN AND FAMILY SERVICES 

15 TO REIMBURSE ADDITIONAL SHORTAGES IN THE DEPARTMENT'S T.H.P. 

16 YOUTH TRUST FUND. AND ON THIS ITEM, THERE ARE REQUESTS FROM 

17 MEMBERS OF THE PUBLIC TO HOLD IT. ON ITEM NO. 62-C, SUPERVISOR 

18 ANTONOVICH WOULD LIKE TO AMEND HIS MOTION TO ADD TO IT THAT 

19 THE DEPARTMENT OF PUBLIC WORKS PROCEED WITH ALTERNATIVE 4 AS 

20 THE PREFERRED TRUCK ROUTE AS DISCUSSED IN THE COMMUNITY 

21 MEETINGS THAT ITEM IS BEFORE YOU. 62-C. 

22

23 SUP. ANTONOVICH, MAYOR: SO MOVED. SECONDED BY SUPERVISOR 

24 MOLINA. WITHOUT OBJECTION, SO ORDERED. 

25
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1 CLERK SACHI HAMAI: ON ITEM NO. 62-D, WE WILL HOLD THIS FOR A 

2 DISCUSSION. ON PAGE 39, ITEMS CONTINUED FROM PREVIOUS MEETINGS 

3 FOR FURTHER DISCUSSION AND ACTION BY THE BOARD/ ON ITEM NO. A-

4 4, THE DEPARTMENT OF HEALTH SERVICES WOULD LIKE TO AMEND THEIR 

5 RECOMMENDATION ON MEMO A TO READ AS FOLLOWS: AUTHORIZE THE 

6 DIRECTOR OF HEALTH SERVICES TO EXECUTE AN AGREEMENT WITH THE 

7 CALIFORNIA DEPARTMENT OF HEALTHCARE SERVICES FOR 

8 IMPLEMENTATION OF THE LOW INCOME HEALTH PROGRAM UNDER THE NEW 

9 CALIFORNIA 1115 WAIVER SUBJECT TO REVIEW AND APPROVAL BY 

10 COUNTY COUNSEL AND THE CHIEF EXECUTIVE OFFICER AND WITH PRIOR 

11 NOTIFICATION OF THE BOARD OF SUPERVISORS. WITH THAT AMENDMENT, 

12 THE RECOMMENDATIONS CONTAINED IN BOTH MEMO A AND B ARE BEFORE 

13 YOU. 

14

15 SUP. ANTONOVICH, MAYOR: OKAY. SUPERVISOR MOLINA MOVES. 

16 SECONDED WITHOUT OBJECTION, SO ORDERED. 

17

18 CLERK SACHI HAMAI: AND I APOLOGIZE, ON ITEM NO. 62-C, IF WE 

19 COULD GET RECONSIDERATION. THERE'S A MEMBER OF THE PUBLIC THAT 

20 WOULD LIKE TO HOLD THIS ITEM. 

21

22 SUP. ANTONOVICH, MAYOR: 62-C. MOVE RECONSIDERATION? 

23

24 CLERK SACHI HAMAI: YES. 

25
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1 SUP. ANTONOVICH, MAYOR: MOTION BY YAROSLAVSKY. SECONDED IT TO 

2 RECONSIDER 62-C FOR A MEMBER OF THE PUBLIC TO SPEAK ON THAT 

3 ITEM. WITHOUT OBJECTION, SO ORDERED. 

4

5 CLERK SACHI HAMAI: THANK YOU. ON ITEM NO. 41, EXCUSE ME. ON 

6 PAGE 41, NOTICES OF CLOSED SESSION, ON ITEM NO. CS-3, WHICH 

7 WAS POSTED ON THE SUPPLEMENTAL AGENDA, THERE'S A REQUEST FROM 

8 A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND THAT COMPLETES 

9 THE READING OF THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS 

10 BEGIN WITH SUPERVISORIAL DISTRICT NO. 5. 

11

12 SUP. ANTONOVICH, MAYOR: OKAY. FIRST I WANT TO BRING UP TWO 

13 OUTSTANDING EDUCATORS WITHIN THE COUNTY OF LOS ANGELES, DR. 

14 EDWIN DIAZ AND DR. ALICE PETROSSIAN, THE SUPERINTENDENT AND 

15 THE CHIEF ACADEMIC OFFICER FOR THE PASADENA UNIFIED SCHOOL 

16 DISTRICT ON THEIR RETIREMENT. ED WILL BE LEAVING FOR GREENER 

17 PASTURES AS HE RETURNS TO HIS NATIVE GILROY TO GROW GARLIC IN 

18 THE BACKYARD, RIGHT? [LAUGHTER.] AND BEFORE MOVING TO PASADENA 

19 IN 2007, ED HAD BEEN A FIXTURE IN GILROY, WHERE HE HAD GROWN 

20 UP AND WORKED AS AN EDUCATOR AND ADMINISTRATOR. AS 

21 SUPERINTENDENT, HE HAD OVERSEEN THE DISTRICT OF 18,000 

22 STUDENTS AND IS CREDITED WITH RAISING THE DISTRICT'S TEST 

23 SCORES AT A FASTER PACE THAN THE STATE OF CALIFORNIA. 

24 ADDITIONALLY, HIS INITIATIVES INCLUDED FOCUSING ON IMPROVING 

25 MIDDLE AND SENIOR HIGH SCHOOLS, REDUCING THE DROPOUT RATE AND 
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1 OVERSEEING A NEW MASTER PLAN FOR THE FACILITIES AND WORKED FOR 

2 THE EFFORT TO REDUCE, AS WE DO AT THIS BOARD, AS WELL, LEGAL 

3 COSTS, WHICH EAT UP MANY OF OUR GOOD BUDGETS. IN 2009, HE WAS 

4 SELECTED AS A DISTINGUISHED EDUCATOR BY THE CALIFORNIA STATE 

5 UNIVERSITY OF LOS ANGELES. AND HE WAS A MEMBER OF THE TEAM K-

6 12 OF UNIVERSITY EDUCATORS WHO TRAVELED TO SOUTH AFRICA TO 

7 ASSIST WITH THE PUBLIC SCHOOLS PROGRAM AND ALSO INVOLVED WITH 

8 THE BRIGHT SCHOLARS PROGRAM THAT DR. SANDRA THOMAS HAS 

9 INITIATED IN THE ALTADENA PASADENA AREA THAT REALLY CREATES A 

10 GREAT OPPORTUNITY FOR OUR YOUNG PEOPLE TO DEVELOP THEIR 

11 CHARACTER SKILLS AND GO ON TO HIGHER EDUCATION. ALICE 

12 PETROSSIAN, SHE'S THE DISTRICT'S CHIEF ACADEMIC OFFICER AND 

13 HAS LED THAT CHANGE TO IMPROVE THE LEVEL OF EDUCATION FOR 

14 THOSE 18,000 STUDENTS, PREVIOUSLY SERVING AS ASSISTANT 

15 SUPERINTENDENT OF EDUCATIONAL SERVICES FOR GLENDALE UNIFIED 

16 SCHOOL DISTRICT, AND SHE AND HER HUSBAND ALSO TRAVELED TO 

17 ARMENIA THROUGH THE ARMENIAN EDUCATION FOUNDATION TO BUILD 

18 IMPOVERISHED SCHOOLS IN THE BORDER REGIONS. SHE'S A RECIPIENT 

19 OF NUMEROUS ACCOLADES FOR HER ACHIEVEMENT IN SCHOOL REFORM, 

20 INCLUDING THE OUTSTANDING ADMINISTRATOR AWARD FROM THE 

21 ASSOCIATION OF CALIFORNIA SCHOOL ADMINISTRATORS. AND I HAVE 

22 KNOWN ALICE SINCE SHE WAS A STUDENT AND WATCHED HER MATURE 

23 INTO ONE OF THEIR BRIGHT EDUCATORS. AND SHE IS THE PRIDE OF 

24 HER PARENTS AND HER AUNTS AND UNCLES AND HER FAMILY AND HER 

25 BROTHER AND ALL AND HER HUSBAND AND CHILDREN. AND WE REALLY 
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1 APPRECIATE THE GREAT LEADERSHIP THAT THIS TEAM PROVIDED THE 

2 PASADENA SCHOOLS. SO FIRST, LET ME GIVE THIS TO DR. DIAZ. AND 

3 THEN LET ME -- 

4

5 EDWIN DIAZ: FIRST OF ALL, I'D LIKE TO EXPRESS MY APPRECIATION 

6 TO SUPERVISOR ANTONOVICH AND THE COUNTY SUPERVISORS FOR THIS 

7 RECOGNITION. IT'S CERTAINLY BEEN A PLEASURE TO WORK IN THE 

8 COUNTY OF LOS ANGELES AND HAVE REALLY, REALLY BENEFITED FROM 

9 THE SUPPORT OF A STRONG COUNTY AND THE COMMUNITY OF PASADENA. 

10 SO THANK YOU FOR THE RECOGNITION. 

11

12 ALICE PETROSSIAN: I THOUGHT I WAS OLDER, MIKE. I'VE KNOWN 

13 SUPERVISOR ANTONOVICH SINCE HIS FIRST RUN FOR OFFICE. AND IT 

14 HAS BEEN A PLEASURE TO HAVE SUPPORTED HIM ALL THROUGH THOSE 

15 WONDERFUL CAREER MOVES. IT'S BEEN ALSO A PLEASURE TO BE A 

16 CONSTITUENT OF HIS. AND I'M STAYING PUT. AND I WILL CONTINUE 

17 TO WORK WITH AND AROUND PUBLIC EDUCATION FOR AS LONG AS THE 

18 GOOD LORD WISHES. AND I WANT TO THANK THE SUPERVISORS FOR 

19 RECOGNIZING US FOR OUR SERVICE. BUT IT'S ALL ABOUT THE 

20 CHILDREN. SO THANK YOU AGAIN. [APPLAUSE.] 

21

22 SUP. ANTONOVICH, MAYOR: NOW WE WANT TO RECOGNIZE TWO 

23 CALIFORNIA DISTINGUISHED SCHOOLS. TODAY WE WANT TO RECOGNIZE 

24 THE TWO THAT ARE FROM THE FIFTH SUPERVISORIAL DISTRICT AS THE 

25 2011 CALIFORNIA DISTINGUISHED SCHOOLS BY THE STATE OF 
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1 CALIFORNIA'S DEPARTMENT OF EDUCATION. THIS IS NOW IN ITS 26 

2 YEAR, WHICH IDENTIFIES AND HONORS THE STATE'S MOST EXEMPLARY 

3 AND INSPIRING PUBLIC SCHOOLS WITHIN OUR STATE. ALTHOUGH 

4 PARTICIPATION IS VOLUNTARY, THE AWARD IS HIGHLY SOUGHT AFTER 

5 BY SCHOOLS IN ALL AREAS OF THE STATE, ELEMENTARY AND 

6 SECONDARY, AND RECOGNIZED DURING ALTERNATE YEARS. ALL 

7 APPLICANTS UNDERWENT A VERY RIGOROUS SELECTION PROCESS 

8 CONDUCTED BY THE CALIFORNIA DEPARTMENT OF EDUCATION, WITH THE 

9 HELP OF MANY LOCAL EDUCATORS ACROSS THE STATE. OF THE 19 

10 SCHOOLS IN LOS ANGELES COUNTY THAT RECEIVED THE PRESTIGIOUS 

11 RECOGNITION, FOUR ARE LOCATED IN OUR FIFTH SUPERVISORIAL 

12 DISTRICT. THESE REMARKABLE SCHOOLS HAVE SHOWN GREAT GAINS THAT 

13 CAN BE ACCOMPLISHED BY HAVING HIGHER EXPECTATIONS OF OUR 

14 CHILDREN. FROM PASADENA, WE HAVE BLAIR HIGH SCHOOL. DR. DIAZ? 

15 AND FROM THE SAN FERNANDO VALLEY, GRENADA HILLS CHARTER HIGH 

16 SCHOOL. CONGRATULATIONS. 

17

18 SPEAKER: I'D ALSO LIKE TO ADD MY THANKS TO SUPERVISOR 

19 ANTONOVICH FOR HIS SUPPORT OF PASADENA, ALTADENA AND SIERRA 

20 MADRE THROUGHOUT THE YEARS. AND I APPRECIATE THIS RECOGNITION. 

21 I ACCEPT IT ON BEHALF OF ALL THE TEACHERS, STAFF AND STUDENTS 

22 OF BLAIR HIGH SCHOOL. 

23

24 SPEAKER: GOOD MORNING. ON BEHALF OF GRENADA HILLS CHARTER HIGH 

25 SCHOOL, THE STUDENTS, THE TEACHERS, THE COMMUNITY, WE ARE SO 
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1 PROUD AND HONORED TO BE A PART OF THIS. IT IS SUCH AN 

2 ACKNOWLEDGMENT AND IT REALLY DOES BEGIN AT THE FOUNDATION. SO 

3 VERY PHENOMENAL AND THE TEACHERS AND STUDENTS ARE SO PROUD TO 

4 BELONG TO A SCHOOL LIKE GRENADA. SO THANK YOU SO MUCH. 

5

6 SUP. ANTONOVICH, MAYOR: NOW WE HAVE A LITTLE ONE-YEAR BOY, A 

7 BLACK-TAN SCOTTY WHO IS LOOKING FOR A HOME. THIS IS LITTLE 

8 SCOTTY. AH. HE LIKES HAWAIIAN FOOD. ANYBODY WHO'D LIKE TO 

9 ADOPT LITTLE SCOTTY, YOU CAN CALL 562-728-4644. OR ANYBODY IN 

10 THE AUDIENCE WHO WOULD LIKE TO ADOPT LITTLE SCOTTY. SEE 

11 ANYBODY? SUPERVISOR MOLINA? ZEV? 

12

13 SUP. YAROSLAVSKY: I HAVE A COUPLE PRESENTATIONS THIS MORNING. 

14 AND FIRST I'D LIKE TO ASK KEALI'I CEBALLOS TO JOIN ME HERE. 

15 MEMBERS OF THE BOARD, KEALI'I CEBALLOS IS A LOS ANGELES 

16 RESIDENT OF 20 YEARS' STANDING WHO IS A RENOWNED PERFORMER AND 

17 AND PROMOTER OF ASIAN PACIFIC ISLANDER CULTURE AND TEACHER OF 

18 HAWAIIAN, TAHITIAN AND MAORI DANCING, THE HULA, AND THE 

19 LANGUAGE AND SONGS OF THE ISLANDS. HE'S THE FOUNDER OF HALAU 

20 KEALI'I O NALANI, A DANCE TROUPE NAMED IN HONOR OF HIS MOTHER, 

21 CECELIA CECELANI CEBALLOS, HERSELF A FORMALLY TRAINED AND 

22 PROFESSIONALLY ACCOMPLISHED HULA DANCER, INSTRUCTOR AND 

23 CHOREOGRAPHER, KNOWN AS AUNTIE SISSY, WHO WAS WIDELY 

24 CELEBRATED FOR HER WORK IN THE 1940S FILM INDUSTRY. HIS 

25 STUDENTS AND DANCE TROUPE HAVE PERFORMED ALL OVER THE WORLD 
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1 FOR DIGNITARIES RANGING FROM PRESIDENTS OF THE UNITED STATES 

2 TO LOCAL ELECTED OFFICIALS AND GENERAL AUDIENCES IN JAPAN, 

3 MEXICO, JAVA, HAWAII, AND MANY OTHER LOCATIONS, INCLUDING ONLY 

4 LAST FALL OUR OWN JOHN ANSON FORD AMPHITHEATRE AS HEADLINERS 

5 IN THE PROGRAM "ALOHA FEST, RHYTHM OF THE ISLANDS." DESPITE 

6 HIS DEMANDING PROFESSIONAL SCHEDULE, KEALI'I HAS DEVOTED 

7 COUNTLESS HOURS OF VOLUNTEER EFFORT ON BEHALF OF AIDS 

8 PREVENTION, CANCER AWARENESS AND OTHER WORTHY CHARITABLE 

9 EFFORTS. THE BOARD OF SUPERVISORS WANTS TO TAKE THIS 

10 OPPORTUNITY TO HIGHLY COMMEND YOU, KEALI'I, FOR THE 20 YEARS 

11 OF OUTSTANDING CONTRIBUTIONS TO THE CULTURAL DIVERSITY AND 

12 ARTISTIC VIBRANCY OF LOS ANGELES AND OUR REGION THROUGH YOUR 

13 PERFORMANCE AND TEACHING OF ASIAN PACIFIC ISLANDER DANCE, 

14 LANGUAGE AND MUSIC. AND YOU ARE EXTENDED SINCERE BEST WISHES 

15 FOR CONTINUED SUCCESS IN ALL OF YOUR FUTURE ENDEAVORS. AND I 

16 WANT TO PRESENT THIS TO YOU. AND I UNDERSTAND YOU'RE GOING TO 

17 GRACE US WITH A BRIEF PERFORMANCE. ALL RIGHT. WELL THAT'S 

18 COOL. 

19

20 KEALI'I CEBALLOS: MAHALO. IT'S INDEED AN HONOR TO RECEIVE 

21 THIS, AND ON BEHALF OF ALL THE STUDENTS THAT I TEACH 

22 INTERNATIONALLY AS WELL AS HERE LOCALLY, I APPLAUD THE 

23 STUDENTS FOR THEIR INSPIRATION TO LEARN ABOUT THESE CULTURES 

24 OF THE PACIFIC, AND I WILL CONTINUE TO SHARE AS MUCH AS I CAN 

25 WITH THE GREATER LOS ANGELES AREA FOR AS LONG AS I AM ABLE TO. 
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1 SO MAHALO NUI TO SUPERVISOR YAROSLAVSKY. AND YES WE SHARE WITH 

2 YOU A MELE ABOUT THE ISLAND OF OAHU. MOST OF YOU ARE VERY 

3 AWARE OF OF THE AREA KNOWN AS WAIKIKI. SO WE DANCE IN HONOR OF 

4 THE ANCIENT NAME OF WAIKIKI AS HULUMOA. [MUSIC.] [MUSIC.] 

5 [APPLAUSE.] 

6

7 SUP. YAROSLAVSKY: IF YOU ALL WILL COME BACK UP HERE, I CAN 

8 PRESENT YOU WITH THIS PROCLAMATION AGAIN. CAN WE GET ALL THE 

9 DANCERS UP HERE FOR A GROUP PHOTO? NEXT I'D LIKE TO ASK KEIKO 

10 MORI AND MAREK SZPAKIEWICZ TO JOIN ME FOR THIS PRESENTATION. 

11 AND MR. ANTONOVICH, THEY ARE YOUR CONSTITUENTS, SO MAYBE YOU 

12 WANT TO JOIN ME, TOO. WHILE THEY'RE WALKING UP, LET ME READ 

13 THIS PROCLAMATION. KEIKO MORI AND MAREK SZPAKIEWICZ, BORN AND 

14 RAISED IN THEIR RESPECTIVE COUNTRIES OF JAPAN AND POLAND -- 

15 COME JOIN ME HERE -- ARE NOW LOS ANGELES COUNTY RESIDENTS AND 

16 A MARRIED COUPLE OF UNCOMMON TALENTS AND SINGULAR ARTISTIC 

17 DEDICATION. WITH KEIKO AN ACCOMPLISHED WRITER AND EDITOR WITH 

18 DEGREES IN POLITICAL SCIENCE, COMMUNICATIONS, AND PROFESSIONAL 

19 CREATIVE WRITING, AND MAREK AN INTERNATIONALLY RENOWNED 

20 CLASSICAL CELLIST WHO EARNED PERMANENT RESIDENCY STATUS IN 

21 2008 AS AN EXTRAORDINARY ABILITY ARTIST. AND DEEPLY MOVED BY 

22 THE PLIGHT OF THE THOUSANDS OF VICTIMS OF THE MARCH 11 

23 EARTHQUAKE AND TSUNAMI IN HER NATIVE JAPAN, KEIKO AND HER 

24 HUSBAND MAREK UNDERTOOK TO ORGANIZE A CHARITY EVENT SCHEDULED 

25 FOR JUNE 9 AT BARNSDALL GALLERY THEATER IN HOLLYWOOD TITLED 
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1 "FOR JAPAN, WE'RE UNITED" TO RAISE RELIEF FUNDS TO ASSIST 

2 THOSE DIRECTLY AFFECTED AND TO PROMOTE EARTHQUAKE PREPAREDNESS 

3 HERE IN LOS ANGELES COUNTY. "FOR JAPAN, WE'RE UNITED" HAS WON 

4 THE SUPPORT OF THE CITY OF LOS ANGELES, THE SOUTHERN 

5 CALIFORNIA RESEARCH CENTER FOR A.L.P.D. IN CIRRHOSIS, THE 

6 CONSULATE GENERAL OF JAPAN IN LOS ANGELES AND THE JAPAN-

7 AMERICA SOCIETY WITH THE PARTICIPATION OF K.T.L.A. MORNING 

8 NEWS, THE LOS ANGELES FIRE DEPARTMENT AND CLASSICAL RADIO 

9 STATION K.U.S.C. 100 PERCENT OF THE PROCEEDS FROM THE 

10 PERFORMANCE AND ACCOMPANYING AUCTION WILL BE DESIGNATED FOR 

11 THE 2011 JAPAN RELIEF FUND. THE BOARD OF SUPERVISORS OF THE 

12 COUNTY OF LOS ANGELES WANT TO TAKE THIS OPPORTUNITY TO COMMEND 

13 KEIKO MORI AND MAREK SZPAKIEWICZ FOR THEIR SELFLESS AND 

14 DEDICATED EFFORT TO PROMOTE EARTHQUAKE PREPAREDNESS AND RAISE 

15 RELIEF FUNDING TO ASSIST THE VICTIMS OF THE 2011 JAPANESE 

16 EARTHQUAKE AND TSUNAMI, AND THEY ARE EXTENDED OUR SINCERE BEST 

17 WISHES FOR A MOST SUCCESSFUL EVENT AND CONTINUED FULFILLMENT 

18 IN ALL THEIR FUTURE ENDEAVORS. AND THE DATE OF THAT EVENT 

19 AGAIN IS JUNE 9, AT BARNSDALL GALLERY THEATER AT WHAT TIME? 

20

21 KEIKO MORI: 7:30. 

22

23 SUP. YAROSLAVSKY: 7:30 IN THE EVENING. AND SO EVERYONE CAN 

24 COME AND ENJOY A GREAT PERFORMANCE OR PERFORMANCES AND HELP 



June 7, 2011

24

1 DEFRAY SOME OF THE COSTS AND CONTRIBUTE TO THE RELIEF IN 

2 JAPAN. THANK YOU, KEIKO. [APPLAUSE.] 

3

4 KEIKO MORI: THANK YOU SO MUCH FOR HAVING US HERE TODAY AND 

5 THANK YOU SO MUCH FOR SUPERVISOR YAROSLAVSKY AND ALSO 

6 ANTONOVICH FOR RECOGNITION OF THIS CAUSE WE ARE DOING. ON THE 

7 NINTH, THURSDAY, THIS WEEK, WE'LL HAVE THIS FUNDRAISING EVENT, 

8 FOR JAPAN WE'RE UNITED, AT BARNSDALL GALLERY THEATER IN 

9 HOLLYWOOD. AND THIS EVENT STARTED WITH JUST THE TWO OF US 

10 WANTING TO DO SOMETHING RIGHT AFTER THE MARCH 11 EARTHQUAKE 

11 AND TSUNAMI IN JAPAN. BUT WE COULDN'T DO IT WITHOUT ALL THE 

12 HELP WE RECEIVED FROM THE CITY OF LOS ANGELES DEPARTMENT OF 

13 CULTURAL AFFAIRS AND ALSO THE JAPANESE CONSULATE GENERAL IN 

14 LOS ANGELES AND THE JAPAN AMERICA SOCIETY. THIS IS REALLY 

15 CLOSE TO MY HEART. AND WE HAVE -- IN THE EVENT WE HAVE NOT 

16 JUST MUSIC. WE HAVE SOME EARTHQUAKE PREPAREDNESS TIPS FROM 

17 L.A.F.D., THEIR PROGRAM OFFICER, BECAUSE HERE IN LOS ANGELES, 

18 WE HAVE EARTHQUAKES TOO. SO WE WOULD LIKE TO PREPARE PEOPLE 

19 FOR LOS ANGELES RESIDENTS. ALL THE PROCEEDS GO TO THE 2011 

20 JAPAN RELIEF FUND. AND WE WOULD LIKE TO THANK YOU AGAIN FOR 

21 LETTING EVERYBODY KNOW THAT FOR JAPAN WE'RE UNITED. THANK YOU 

22 SO MUCH. 

23

24 MAREK SZPAKIEWICZ: WELL, WE'RE TRYING TO BRING EARTHQUAKE 

25 AWARENESS TO THIS LAND, BUT WE ALSO HAVE A DEEPER MESSAGE OF 
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1 HUMAN KINDNESS THAT WE ARE TRYING TO HELP EACH OTHER. THAT'S 

2 WHAT AMERICA IS ABOUT. AND THAT'S WHY WE ARE HERE. THANK YOU. 

3

4 SUP. ANTONOVICH, MAYOR: I'D LIKE TO MAKE THE FOLLOWING 

5 ADJOURNMENTS. ONE TO A PERSONAL FRIEND AND GOOD SUPPORTER OVER 

6 THE YEARS, THAT WAS SECRETARY OF STATE LAWRENCE EAGLEBURGER, 

7 WHO PASSED AWAY THIS PAST WEEK AT THE AGE OF 80. I SERVED AS A 

8 MEMBER OF THE DELEGATION TO THE UNITED NATIONS INDO-CHINESE 

9 REFUGEES THAT HE HEADED TO GENEVA. AND HAD MANY INTERESTING 

10 TIMES WITH LARRY. HE SERVED IN THE NIXON ADMINISTRATION, 

11 EXECUTIVE ASSISTANT TO THE SECRETARY OF STATE HENRY KISSINGER. 

12 HE WAS AMBASSADOR TO YUGOSLAVIA UNDER PRESIDENT CARTER AND 

13 ASSISTANT SECRETARY OF STATE AND THEN UNDERSECRETARY OF STATE 

14 DURING PRESIDENT REAGAN'S FIRST TERM. AND HE HELPED TO DEVELOP 

15 THE NATIONAL SECURITY COUNCIL. AND THEN HE WAS THE SECRETARY 

16 OF STATE WITH PRESIDENT GEORGE H.W. BUSH'S ADMINISTRATION. HE 

17 WAS MARRIED TO THE FORMER MARLENE ANN HEINEMANN, WHO PASSED 

18 AWAY THIS PAST YEAR. AND HE HAD THREE SONS. ANOTHER GOOD 

19 FRIEND, LONGTIME FRIEND, MATT FONG, PASSED AWAY AT THE AGE OF 

20 57. HE WAS A LIEUTENANT COLONEL IN THE AIR FORCE RESERVE, 

21 ELECTED STATE TREASURER IN 1994 AND RECEIVED THE REPUBLICAN 

22 PARTY NOMINATION WHEN HE CHALLENGED SENATOR BOXER FOR HER 

23 SENATE SEAT IN 1994. HE WAS A GRADUATE OF SOUTHWESTERN LAW 

24 SCHOOL. HE WAS MARRIED 33 YEARS TO PAULA, AND THEIR TWO 

25 CHILDREN MATT AND JADE. HIS FATHER, CHESTER FONG, HE LEAVES; 
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1 AND SISTERS, DUYUN STEIN, AND I MENTIONED JADE AND MATTHEW II, 

2 HIS SON WE WENT TO CHINA A FEW TIMES TOGETHER, WORKED IN THE 

3 VARIOUS REPUBLICAN CAMPAIGNS. HIS MOM ALWAYS USED TO CHIDE ME 

4 BECAUSE I HELPED MAKE HER SON A REPUBLICAN, BUT SHE ALWAYS HAD 

5 A BIG SMILE ON HER FACE. IT WAS ALSO A WONDERFUL 

6 REPRESENTATIVE FOR OUR STATE WHICH HE SERVED FOR MANY YEARS AS 

7 SECRETARY OF STATE AND LATER AS AN AMBASSADOR TO MICROASIA. 

8 ROBERT HARMS, HE WAS THE FATHER OF OUR COUNTY PHOTOGRAPHER, 

9 SCOTT HARMS, LONGTIME RESIDENT, WHO WORKED FOR 35 YEARS WITH 

10 THE ALHAMBRA UNIFIED SCHOOL DISTRICT BEFORE HIS RETIREMENT AND 

11 MOVE TO OREGON. SO HE LEAVES HIS WIFE DELORIS AND CHILDREN, 

12 CINDY AND SCOTT. AUSTRA ANDERSON, SHE PASSED AWAY AT THE AGE 

13 OF 90. LONGTIME RESIDENT OF PASADENA, PRESIDENT OF THE EAST 

14 PASADENA SIERRA MADRE REPUBLICAN WOMEN'S CLUB AND VICE 

15 PRESIDENT OF THE LOS ANGELES COUNTY FEDERATION OF REPUBLICAN 

16 WOMEN. JAMES ARNESS, ONE OF THE GREAT ACTORS IN HOLLYWOOD, WHO 

17 PLAYED MARSHAL MATT DILLON IN THE TELEVISION SERIES, 

18 "GUNSMOKE." WALLY BOAG PASSED AWAY AT THE AGE OF 90. FOR 30 

19 YEARS AND 40,000 PERFORMANCES, HE DELIGHTED YOUNGSTERS, YOUNG 

20 AND OLD, AS PECOS BILL, THE COWBOY COMEDIAN IN THE GOLDEN 

21 HORSESHOE IN DISNEYLAND. HE ALSO HELPED BECOME A MEMBER IN THE 

22 "GUINNESS BOOK OF RECORDS" AS THE MOST PERFORMED STAGE 

23 PRODUCTION IN THE HISTORY. AND HE IS SURVIVED BY HIS WIFE AND 

24 HIS SON AND DAUGHTER. DONALD "WAYNE" HOLLOWAY. HE WAS A AIR 

25 FORCE VETERAN OF THE KOREAN CONFLICT AND PROMOTED THE GROWTH 
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1 AND ECONOMIC PROSPERITY OF THE ANTELOPE VALLEY IN THE REAL 

2 ESTATE INDUSTRY. WILLIAM "BILL" CHRISTIAN KROYER, A CLASSMATE 

3 OF MINE FROM JOHN MARSHALL HIGH SCHOOL. HE GRADUATED AND THEN 

4 SERVED IN THE UNITED STATES NAVY. AND BILL LEAVES HIS 

5 CHILDREN, ERIC AND DEANNA, AND GRANDCHILDREN. WINNIE ANN 

6 LIMBOURNE. SHE'S FROM ACTON. SHE WAS WITH THE SULPHUR SPRINGS 

7 SCHOOL DISTRICT FOR OVER 40 YEARS AND WAS ALSO INVOLVED WITH 

8 THE A.K.C. DOG SHOW JUDGE AS AN EXHIBITOR/BREEDER OF CHAMPION 

9 LABRADOR RETRIEVERS. TWO VERY GOOD FRIENDS, COMMUNITY LEADERS 

10 IN THE SUNLAND-TUJUNGA AREA, AND THAT WAS TED MERTZ AND HIS 

11 WIFE, LYDIA. TED PASSED AWAY ON MAY 20 AT THE AGE OF 95, AND 

12 LYDIA PASSED AWAY BASICALLY ABOUT THREE WEEKS LATER, TWO TO 

13 THREE WEEKS LATER AT THE AGE OF 85 ON JUNE 6. AND THEY WERE 

14 FROM ANTELOPE VALLEY FROM THE SUNLAND-TUJUNGA AREA. THEY MOVED 

15 TO PALMDALE. AND THEY WERE SURVIVED BY THEIR SEVEN CHILDREN. 

16 CARL MINTON, HE WAS A RESIDENT OF SAN GABRIEL VALLEY, SERVED 

17 THE UNITED STATES ARMY AND THEN THE U.S. AIR FORCE DURING THE 

18 KOREAN WAR. HE WAS ONE OF OUR OUTSTANDING LAWYERS, WHERE HE 

19 RECEIVED HIS LAW DEGREE FROM U.S.C. AND HIS PRIVATE PRACTICE 

20 WAS IN DOWNTOWN LOS ANGELES. HE WAS A MEMBER OF THE SAN MARINO 

21 MASONIC LODGE, THE TOASTMASTERS, ROTARY CLUB, AND JONATHAN 

22 CLUB. BILL PLUMLEY PASSED AWAY ON JUNE 1, ALSO A NAVY VETERAN. 

23 HIS WIFE WAS FORMER MAYOR OF THE CITY OF GLENDALE AND SERVED 

24 MANY TERMS AS A COUNCILWOMAN. AND HE WAS QUITE INVOLVED IN 

25 THOSE ACTIVITIES WITH HIS WIFE. HE HAD A 30-YEAR CAREER WITH 
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1 L.A. CITY DEPARTMENT OF WATER AND POWER BEFORE HE BECAME THE 

2 EXECUTIVE DIRECTOR OF THE COMMERCIAL DIVISION AND THEN SERVED 

3 AS EXECUTIVE DIRECTOR OF THE GLENDALE ASSOCIATION OF REALTORS. 

4 MIGUEL RODRIGUEZ, JR. PASSED AWAY AT THE AGE OF 64, RETIRED 

5 DEPUTY SHERIFF. HIS LAST ASSIGNMENT WAS THE FACILITY SERVICE 

6 BUREAU. EUNICE MAXWELL SCHWAKE PASSED AWAY AT THE AGE OF 98, 

7 FROM THE ANTELOPE VALLEY. AND A GOOD FRIEND, A REAL GOOD ROLE 

8 MODEL AND A GOOD FRIEND TO THE TAXPAYERS OF OUR COUNTY AND 

9 STATE, AND THAT'S EDDY TANAKA, WHO PASSED AWAY ON JUNE 2. HE 

10 STARTED THE D.P.S.S. AS A SOCIAL WORKER TRAINEE IN 1958, LATER 

11 BECAME THE DIRECTOR OF THE DEPARTMENT OF PUBLIC SOCIAL 

12 SERVICES FROM 1980 TO 1996. HE HAD A CAREER WITH OUR COUNTY 

13 FOR FIVE DECADES. HE WAS ALSO THE AMERICAN CITY AND COUNTY 

14 LEADER OF THE YEAR IN 1996. HE HAD A SHORT TWO-YEAR STINT WITH 

15 THE UNITED STATES ARMY. HE WAS A MAN OF THE HIGHEST HONESTY 

16 AND INTEGRITY. AND HE WAS JUST A GOOD MAN. HE WAS ONE OF THE 

17 BEST MANAGERS WE HAVE HAD IN OUR COUNTY'S HISTORY BECAUSE 

18 THOSE TYPES OF INDIVIDUALS ARE VERY, VERY RARE. AND HE'S 

19 SURVIVED BY HIS CHILDREN, LAURIE, STEVEN, AND DAVID. AND HIS 

20 SERVICE IS GOING TO BE THIS SATURDAY AT ROSE HILLS AT I 

21 BELIEVE 9 O'CLOCK IN THE MORNING. AND THEN DR. BURTIS EARL 

22 TAYLOR PASSED AWAY AT THE AGE OF 90. HE WAS A FORMER 

23 SUPERINTENDENT OF THE GLENDALE UNIFIED SCHOOL DISTRICT, WHERE 

24 HE SERVED FOR 14 YEARS. AND PRIOR TO THAT HE HAD BEEN WITH THE 

25 ASSISTANT SUPERINTENDENT IN RIVERSIDE AND ARCADIA. HE REMAINED 
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1 ACTIVE IN EDUCATION. I WORKED WITH DR. TAYLOR WHEN I WAS IN 

2 THE STATE LEGISLATURE AND LATER AS A SUPERVISOR. AND THEN 

3 CHARLES YINGST OF THE ANTELOPE VALLEY, RESIDENT OF LITTLEROCK. 

4 HE SERVED FOR 23 YEARS ON THE BOARD OF THE LITTLEROCK CREEK 

5 IRRIGATION DISTRICT. SO SECONDED BY SUPERVISOR KNABE. WITHOUT 

6 OBJECTION, SO ORDERED. ALL MEMBERS ON TANAKA AND FONG. 

7

8 CLERK SACHI HAMAI: (OFF MIC.) 

9

10 SUP. ANTONOVICH, MAYOR: OKAY. WE'RE GOING TO DO ITEMS 1, 22, 

11 30 AND 32 AND GENEVIEVE CLAVREUL, PLEASE COME UP. GOOD 

12 MORNING. 

13

14 DR. GENEVIEVE CLAVREUL: GOOD MORNING, DR. GENEVIEVE CLAVREUL. 

15 WELL, I THINK IT'S NOT A GOOD MORNING WHEN DEFINITIVELY IT'S 

16 BEING MORE COMMON HERE AT THE BOARD OF SUPERVISORS TO MAKE A 

17 JOKE AND A FARCE OF THE INPUT FROM THE PUBLIC. AND IT'S 

18 GETTING WORSE AND WORSE EVERY DAY. AND IT'S A VERY SAD DAY. ON 

19 ITEM NO. 1, I HAVE THE SAME COMPLAINT I HAVE HAD FOR THE LAST 

20 10 YEARS, IS THAT -- WELL IF MS. MOLINA WILL STOP HAVING A 

21 SIDE CONVERSATION, IT WILL BE NICE. YOUR CONTEMPT OF THE 

22 PUBLIC IS VERY EVIDENT. OH NO, YOU'RE NOT INTERESTED, IT'S 

23 OBVIOUS. YOU'RE NOT INTERESTED IN ANYTHING THAT THE PUBLIC HAS 

24 TO SAY. 

25
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1 SUP. MOLINA: (OFF MIC COMMENT) BACK AND FORTH. ORIGINALLY WE 

2 HAD A VERY GOOD CONVERSATION ABOUT EIGHT YEARS AGO. AND YOU 

3 HAVE BEEN DISINGENUOUS EVER SINCE. SO YOU SPEAK TO YOURSELF 

4 ALL DAY LONG. 

5

6 DR. GENEVIEVE CLAVREUL: WOULD YOU STOP MY TIME, SUPERVISOR 

7 ANTONOVICH. 

8

9 SUP. ANTONOVICH, MAYOR: OKAY, BEGIN. 

10

11 DR. GENEVIEVE CLAVREUL: IT'S OBVIOUS THE H.I.V. COMMISSION IS 

12 GOING TO CONTINUE TO ELECT MEMBERS WHO ARE EITHER H.I.V. 

13 POSITIVE OR PROVIDING CARE TO PEOPLE WHO ARE H.I.V. POSITIVE. 

14 ANYWAY, THE OTHER NUMBER WAS, WHAT? 22? 

15

16 SUP. ANTONOVICH, MAYOR: IT WAS ITEM NO. 22, 30 AND 32. 

17

18 DR. GENEVIEVE CLAVREUL: 22? 

19

20 SUP. ANTONOVICH, MAYOR: 22. 

21

22 DR. GENEVIEVE CLAVREUL: I AM VERY CONCERNED ABOUT THE DIRECTOR 

23 OF HEALTH SERVICES MAKING THOSE CHANGE AND SO ON. I DON'T KNOW 

24 IF YOU HAVE SEEN, BUT HE'S TRYING TO TOTALLY REVAMP THE 

25 DEPARTMENT OF PUBLIC HEALTH AND REMOVE THE POSITION OF 
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1 SEXUALLY TRANSMITTED DISEASE FROM DR. PETER KERN WHO IS NOT 

2 ONLY AN EXPERT NATIONALLY BUT AN EXPERT INTERNATIONALLY TO 

3 PLACE IT UNDER THE PREROGATIVE OF MR. PEREZ, WHO IS A 

4 LAYPERSON AND HAS NO KNOWLEDGE OF THE VARIOUS S.T.D.S, I THINK 

5 THIS IS PLACING THE PUBLIC HEALTH IN A TREMENDOUS JEOPARDY. 

6 AND I THINK THAT NEEDS TO BE REVIEWED. AND ITEM 32, YOU SAID? 

7

8 SUP. ANTONOVICH, MAYOR: YES. 

9

10 DR. GENEVIEVE CLAVREUL: YES. 32? 

11

12 SUP. ANTONOVICH, MAYOR: 30 AND 32. 

13

14 DR. GENEVIEVE CLAVREUL: OH, 30? ON ITEM 30, IT'S THE SAME 

15 COMPLAINT I HAVE ABOUT THE INFORMATION TECHNOLOGY. YOU KNOW, 

16 WE ARE WRITING CONTRACT AFTER CONTRACT AND NOT KEEPING TRACK 

17 OF THEM. ON ITEM 32, I WANT TO KNOW WHY THE GAY AND LESBIAN 

18 CENTER IS GETTING OVER $300,000 MORE THAN A.H.F. FOR DOING THE 

19 SAME FUNCTION. JUST BE CURIOUS ABOUT THAT. THANK YOU. 

20

21 SUP. ANTONOVICH, MAYOR: THANK YOU, DOCTOR. OKAY. MOTION BY 

22 SUPERVISOR KNABE. SECONDED WITHOUT OBJECTION, SO ORDERED. 

23

24 DR. GENEVIEVE CLAVREUL: I THINK I'M GOING TO FILE THAT CLAIM 

25 NOW. 
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1

2 SUP. ANTONOVICH, MAYOR: DON, DO YOU WANT TO DO YOUR 

3 ADJOURNMENTS OR MOTIONS? 

4

5 SUP. KNABE: THANK YOU, MR. MAYOR, MEMBERS OF THE BOARD. I, 

6 TOO, WOULD LIKE TO JOIN IN. I KNOW IT'S ALL MEMBERS IN THE 

7 ADJOURNING IN MEMORY OF MATT FONG, A LONGTIME FRIEND OF JULIE 

8 AND I. WE ACTUALLY MEET IN 1984 AT THE REPUBLICAN NATIONAL 

9 CONVENTION, AND SITTING NEXT TO US. AND WE INTRODUCED 

10 OURSELVES AND THE REST IS HISTORY. HE HAD A GREAT FIGHT WITH 

11 CANCER AND IT FINALLY GOT THE BEST OF HIM. HE WAS ONLY 57. 

12 MIKE INDICATED IN HIS HISTORY THAT HE WAS A MODEL PUBLIC 

13 SERVANT AND PRINCIPLED AND COMMITTED TO REPRESENTING THE 

14 PEOPLE'S BEST INTEREST. OUR THOUGHTS AND PRAYERS CONTINUE TO 

15 BE WITH HIS WIFE, PAULA, AND MATT AND JADE DURING THIS VERY 

16 DIFFICULT TIME. AND ALSO IN MEMORY OF EDDY TANAKA, AS WELL, 

17 ANOTHER DEDICATED PUBLIC SERVANT OF THE HIGHEST CALIBER AND 

18 LONGTIME RESIDENT OF HACIENDA HEIGHTS. AND HE WILL BE MISSED 

19 AND SURVIVED BY HIS CHILDREN. I KNOW THE ENTIRE COUNTY FAMILY 

20 DEEPLY MOURNS HIS LOSS. ALSO WE ADJOURN IN MEMORY OF MAGDALENA 

21 VALDIVIA, A LONGTIME PATIENT OF RANCHO AND A RENOWNED RANCHO 

22 ARTIST WHO PASSED AWAY RECENTLY. SHE WAS AN AVID ARTIST. SHE 

23 PARTICIPATED IN THE ART OF RANCHO EVERY YEAR, SINCE WE BEGAN 

24 THE PROGRAM IN 1997. WE'D LIKE TO SEND OUR SINCEREST 

25 CONDOLENCES TO HER HUSBAND, GERARDO, AND TO HER FAMILY AND 
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1 FRIENDS. ALSO THAT WE ADJOURN IN MEMORY OF RUBY DAVILLA, A 

2 DEAR FRIEND AND MOTHER OF OUR NEIGHBOR WHO PASSED AWAY LAST 

3 WEEK. SHE IS SURVIVED BY HER SON, RICK. ALSO THAT WE ADJOURN 

4 IN MEMORY OF PAUL WEISENBERGER, WHO PASSED AWAY AT THE AGE OF 

5 95. HE WAS A PEARL HARBOR SURVIVOR, SERVED ON THE U.S.S. 

6 HELENA, SAW VERY INTENSE ACTION IN THE SOUTH PACIFIC THROUGH 

7 THE END OF WORLD WAR II. HE SPENT MANY YEARS AT GENERAL 

8 ELECTRIC APPLIANCE DIVISION, WAS A VERY ACTIVE MEMBER OF THE 

9 ELKS LODGE IN LONG BEACH. HE IS SURVIVED BY HIS WIFE OF 65 

10 YEARS, HARRIET; SEVEN CHILDREN, PAUL, JOAN, JAMES, GOOD FRIEND 

11 JIM, ROBERT, RICHARD, JANET, AND DIANE; TEN GRANDCHILDREN; AND 

12 SIX GREAT GRANDCHILDREN; AND THREE SIBLINGS. ALSO THAT WE 

13 ADJOURN IN MEMORY OF LEONA HILBRANDS WHO PASSED AWAY. SHE IS 

14 SURVIVED BY HER HUSBAND, WARREN. WARREN AND LEONA HAVE BEEN 

15 DEAR FRIENDS THROUGH OUR CHURCH FOR MANY, MANY YEARS. FINALLY, 

16 THAT WE ADJOURN IN MEMORY OF JANELLE KAREN LEONARD, WHO PASSED 

17 AWAY RECENTLY. SHE WAS RAISED IN LAKEWOOD, GRADUATED FROM 

18 LAKEWOOD HIGH SCHOOL AND LONG BEACH CITY COLLEGE. SHE WILL BE 

19 TRULY MISSED. SHE IS SURVIVED BY HER FRIEND, GRAY WOODS; HER 

20 MOTHER, GLORIA; GRANDFATHER, RAYMOND; SISTER, NICOLE, AND MANY 

21 OTHER FAMILY AND FRIENDS. THOSE ARE MY ADJOURNMENTS. 

22

23

24
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1 >>SUP. ANTONOVICH, MAYOR: SECONDED, WITHOUT OBJECTION, SO 

2 ORDERED. (OFF MIC.) 

3

4 SUP. ANTONOVICH, MAYOR: OKAY. 62-B. AND IF TIFFANY FOSTER, 

5 EDDIE JONES, AND ARNOLD SACHS. 

6

7 TIFFANY FOSTER: HI, MY NAME IS TIFFANY FOSTER. 

8

9 SUP. ANTONOVICH, MAYOR: YOU CAN PULL THE MICROPHONE CLOSER TO 

10 YOU. 

11

12 TIFFANY FOSTER: OKAY. HI. I'M TIFFANY FOSTER. THE REASON WHY 

13 I'M SPEAKING ON THIS ISSUE IS BECAUSE SAMUEL SAGO, I HAVE BEEN 

14 HIS CARETAKER SINCE HE WAS OUT OF THE SYSTEM, AND HE'S ONE OF 

15 THOSE KIDS THAT HAS BEEN MISPLACED. HE REQUESTED HIS MONEY IN 

16 MARCH. I HAVE TALKED TO THE SUPERVISORS, THE DIRECTORS OF THE 

17 PROGRAM. I HAVE WENT ALL THE WAY UP UNTIL I COULDN'T GO UP 

18 ANYMORE. THEY GAVE ME EXCUSES, DIFFERENT FABRICATIONS OF THE 

19 SITUATION. AND WE STILL DID NOT COME TO A CONCLUSION UNTIL I 

20 HAD MR. EDDIE JONES REPRESENT US IN THE LOS ANGELES CIVIL 

21 RIGHTS ASSOCIATION. THEN EVERYBODY WANTS TO, YOU KNOW, RUSH TO 

22 TRY TO HELP US. BUT IT WAS TOO LATE. WE REQUESTED THESE FUNDS 

23 THREE MONTHS AGO. MR. SAGO COULD HAVE BEEN WITHOUT A JOB. HE 

24 WAS WITHOUT A HOUSE. AND NO ONE SEEMED TO CARE. THE DIRECTORS, 

25 THE WHOLE SYSTEM WAS JUST -- THE POLICIES AND THE PROCEDURES 
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1 THAT THEY HAD IN PLACE IS NOT WORKING. AND THEY DO NEED TO BE 

2 ADJUSTED. I HAVE SPOKE WITH MR. KAWASAKI, I HAVE SPOKE WITH 

3 MR. DAY, ORTO DAY, MRS. DUQUESNE AND THEY GAVE ME THE 

4 RUNAROUND FOR TWO MONTHS STRAIGHT. AND TOWARDS THE END OF THE 

5 THIRD MONTH, MR. EDDIE JONES STARTED REPRESENTING US AND 

6 HELPING US GET THE FUNDS THAT MR. SAMUEL SAGO PUT INTO THE 

7 PROGRAM, WHICH WAS FOR THE AMOUNT OF $4,664.10. THEY 

8 ORIGINALLY GAVE HIM A CHECK FOR 713 AND TOLD HIM THAT IN SO 

9 MANY WORDS BEST BE ON HIS WAY. AND HE PUT IN MORE MONEY THAT 

10 THEY DIDN'T WANT TO GIVE HIM. 

11

12 SUP. ANTONOVICH, MAYOR: OKAY. MR. JONES? 

13

14 EDDIE JONES: GOOD MORNING TO THE ENTIRE COUNTY BOARD OF LOS 

15 ANGELES HERE. I'M EDDIE JONES, PRESIDENT OF THE LOS ANGELES 

16 CIVIL RIGHTS ASSOCIATION. THIS IS MR. SAMUEL SAGO, WHO HAS 

17 BEEN IN THE FOSTER CARE SYSTEM SINCE HE'S BEEN THREE YEARS 

18 OLD. HE WENT INTO THE TRANSITIONAL HOUSING PROGRAM ON 

19 WILSHIRE. AFTER HIS STAY THERE, HE WAS SUPPOSED TO BE GIVEN 

20 HIS $4,664.10. HOWEVER, FOR THREE MONTHS, THEY WOULD NOT GIVE 

21 HIM HIS MONEY, WHICH PUT HIM INTO HOMELESS STATUS. THE COUNTY 

22 DEPARTMENT OF CHILDREN AND FAMILY SERVICES SHOULD NOT DO THAT. 

23 THEY NEED TO BE REVITALIZED, REJUVENATED. THEY NEED TO HAVE A 

24 NEW POLICY AND PROCEDURE PROGRAM. WE NEED SOME NEW LEADERSHIP 

25 THERE. THERE ARE SOME REALLY RUDE AND DISRESPECTFUL PEOPLE, 
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1 THAT THEY DON'T KNOW WHO YOU ARE. AND THEN WHEN THEY FIND OUT 

2 WHO YOU ARE, THEN THEY SWITCH THEIR SONG A LITTLE BIT. BUT 

3 THERE NEEDS TO BE SOME NEW TRAINING THERE, MS. MOLINA, MARK 

4 AND EVERYBODY. WE NEED TO PAY ATTENTION TO THE DEPARTMENT OF 

5 CHILDREN AND FAMILY SOCIAL SERVICES OR THERE COULD BE A MAJOR 

6 LAWSUIT, MAJOR, ALL OVER THE NEWS, ALL OVER THE COUNTY, ALL 

7 OVER THE CITY, A NATIONAL STORY. AND THAT IS SOMETHING THAT IS 

8 VERY, VERY IMPORTANT. WHEN YOU TAKE A FOSTER CHILD WHO DOESN'T 

9 HAVE A FAMILY, AND YOU DISRESPECT HIM, HE'S A HUMAN BEING WITH 

10 A CIVIL RIGHT, A CONSTITUTIONAL RIGHT AND A HUMAN RIGHT TO BE 

11 TREATED FAIRLY. I DO WANT TO THANK DR. CONTRERAS FOR WHAT SHE 

12 DID BY ASSISTING ME IN A MEETING TO HELP GET HIS CHECK. BUT IT 

13 TOOK THREE MONTHS. IT SHOULD NEVER HAPPEN, EVER, EVER AGAIN. 

14 AND I WOULD LIKE FOR SOMEONE TO ADDRESS MR. SAGO. HE'S AFRAID 

15 TO SPEAK. BUT SOMEONE SHOULD GIVE HIM A HANDSHAKE AND HE 

16 SHOULD BE GETTING A PROCLAMATION FOR BEING ABLE TO HANG FOR 

17 THREE MONTHS WITHOUT HIS MONEY TO GET A PLACE TO STAY. IT'S 

18 NOT RIGHT. 

19

20 SUP. MOLINA: MR. CHAIRMAN? 

21

22 SUP. ANTONOVICH, MAYOR: SUPERVISOR MOLINA? 

23
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1 SUP. MOLINA: YES? FIRST OF ALL, I DON'T KNOW IF THERE WILL BE 

2 A LAWSUIT OR NOT, AND, SIR, I KNOW YOU'RE A LAWYER SO I'M NOT 

3 GOING TO -- 

4

5 EDDIE JONES: NO, I'M NOT ATTORNEY. MS. MOLINA, I'M NOT AN 

6 ATTORNEY. I WANT TO MAKE THAT KNOWN TO THE PUBLIC. I AM AN 

7 ADVOCATE FOR CIVIL RIGHTS AND I ADVOCATE. I AM NOT AN 

8 ATTORNEY. 

9

10 SUP. MOLINA: I DIDN'T ACCUSE YOU OF BEING AN ATTORNEY. I DID 

11 NOT ACCUSE YOU OF BEING AN ATTORNEY. I SAID THERE MAY BE A 

12 LAWSUIT. I DON'T KNOW WHO WILL BRING IT. I DON'T KNOW. ALL I 

13 AM SAYING IS THAT I PERSONALLY WOULD LIKE TO APOLOGIZE FOR 

14 YOU, SIR. WE'VE HAD A VERY DRAMATIC PROBLEM IN THIS PROGRAM. 

15 AND I DO APPRECIATE YOUR PATIENCE. AND WE'VE ALL BEEN 

16 VICTIMIZED COLLECTIVELY. NOT ONLY BECAUSE OF THE SHORTCHANGING 

17 OF THE MONEY, WHICH HAS BEEN RESTORED THE MINUTE THAT WE FOUND 

18 OUT, AND WE FOUND OUT LAST WEEK. WE HAVE TALKED TO THE 

19 DEPARTMENT. AND WE ARE IN THE PROCESS OF GETTING A 

20 CLARIFICATION. ONE OF THE ISSUES THAT WE HAVE UP HERE AS 

21 COUNTY SUPERVISORS IS WE RUN A VERY MASSIVE SYSTEM OF 

22 PROGRAMS. AND WE DELEGATE THESE RESPONSIBILITIES TO A WHOLE 

23 SERIES OF DEPARTMENT HEADS, SUPERVISORS AND OTHER MANAGERS. 

24 AND THIS IS NOT THE ONLY TIME THAT OUR CUSTOMER SERVICE IS 

25 VERY RUDE. AND I'VE SEEN IT AND WE'VE STEPPED IN FROM TIME TO 
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1 TIME TO CORRECT IT. AND WE'RE CONSTANTLY WORKING ON IT. BUT I 

2 THINK IN THIS INSTANCE, I CERTAINLY WANT TO BE SOMEONE WHO'S 

3 GOING TO APOLOGIZE TO YOU. WE KNOW THAT WE'VE MADE EVERY 

4 EFFORT TO MAKE YOU WHOLE, IN OTHER WORDS, TO RETURN YOUR 

5 MONEY. WE'VE HAD SOME FRAUD THAT'S BEEN COMMITTED IN THIS 

6 DEPARTMENT. AND VARIOUS PEOPLE WHO ARE COVERING UP FOR OTHER 

7 PEOPLE. WE'RE TRYING TO GET TO THE BOTTOM OF IT. WE AS 

8 SUPERVISORS JUST FOUND OUT LAST WEEK. BUT ON BEHALF AT LEAST 

9 OF MYSELF AND I THINK THE BOARD, WE REALLY ARE SORRY FOR YOUR 

10 SITUATION AND APOLOGIZE. AND AGAIN I THINK WE'VE ALL BEEN 

11 VICTIMIZED BY SOMEONE WHO'S TAKEN ADVANTAGE OF LAX SUPERVISION 

12 WITHIN THE DEPARTMENT. AND THOSE PEOPLE WILL BE PAYING THE 

13 PRICE. ALL OF US AS MEMBERS OF THE BOARD, WE'RE SHOCKED BY 

14 THIS SITUATION AND QUICKLY TRIED TO CORRECT IT. AND SO ON 

15 BEHALF OF MYSELF AND OTHERS WHO HAVE SEEN THIS HAPPEN, I TRULY 

16 APOLOGIZE TO YOU. AND I ASSURE YOU THERE WILL BE NO 

17 REPERCUSSIONS WHATSOEVER. 

18

19 EDDIE JONES: THANK YOU MS. GLORIA MOLINA. AND I WANT TO THANK 

20 THE BOARD FOR HEARING US OUT. AND MR. SAGO, HE DOESN'T WANT TO 

21 MAKE ANY STATEMENTS RIGHT NOW. BUT THE MOST IMPORTANT PART NOW 

22 THAT HE HAS HIS $4,664.10, BECAUSE HE WAS HOMELESS, NOW HE CAN 

23 ESTABLISH RESIDENCE AND A ROOF OVER HIS HEAD AND SOME 

24 STABILITY ON HIS LIFE. I'D LIKE TO GIVE MR. SAGO A HAND. 

25 [APPLAUSE.] THANK YOU VERY, VERY MUCH. 
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1

2 SUP. ANTONOVICH, MAYOR: LET ME JUST ADD THAT WHAT GLORIA 

3 MOLINA SAID IS ECHOED BY THE BOARD OF SUPERVISORS. SO WE DO 

4 APOLOGIZE. AND THIS IS ONE OF THE PROBLEMS THAT WE'RE TRYING 

5 TO CORRECT, THE BUREAUCRACY THAT PREVENTS PEOPLE FROM GETTING 

6 WHAT THEY ARE ENTITLED TO RECEIVE, RECEIVING IT INSTEAD OF 

7 HAVING EXCUSES AND DELAYS. AND HAD THIS ONE PERSON NOT PASSED 

8 ON, WE DON'T KNOW WHAT WOULD HAVE HAPPENED. 

9

10 EDDIE JONES: MR. ANTONOVICH, MAYOR, SIR, IF I MAY MAKE A 

11 SUGGESTION. MAYBE SOMETIMES LIKE THEY HAVE SECRET SHOPPERS 

12 THAT GO IN THE GROCERY STORE, MAYBE YOU SHOULD HAVE SOME 

13 SECRET PEOPLE GOING TO SOME OF THESE FACILITIES AND ANALYZE 

14 AND EVALUATE SOME OF THE THINGS THAT ARE TRANSPIRING AMONGST 

15 THE SUPERVISORS WHO SUPERVISOR THESE DEPARTMENTS, WHO LOOK AT 

16 PEOPLE -- DOWN ON PEOPLE AND DO NOT ACCEPT THEM FOR THE HUMAN 

17 BEINGS THAT THEY ARE THAT ARE STRUGGLING IN THIS VERY 

18 DIFFICULT AND COMPLEX SOCIETY. THANK YOU VERY MUCH FOR YOUR 

19 TIME. 

20

21 SUP. ANTONOVICH, MAYOR: THANK YOU. 

22

23 SUP. MOLINA: I THINK THAT'S AN EXCELLENT SUGGESTION. 

24

25 SUP. ANTONOVICH, MAYOR: IT IS. 
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1

2 EDDIE JONES: THANK YOU VERY MUCH, MS. MOLINA. GOD BLESS 

3 EVERYONE. 

4

5 SUP. ANTONOVICH, MAYOR: THANK YOU. MR. SACHS? 

6

7 EDDIE JONES: THANK YOU. 

8

9 ARNOLD SACHS: YES, THANK YOU. GOOD MORNING ARNOLD SACHS. I'D 

10 LIKE TO SEND MY APPRECIATION TO THE BOARD FOR STEPPING UP AND 

11 RESTORING THE FUNDS TO THE PEOPLE THAT GOT TAKEN ADVANTAGE OF. 

12 AND FOR THE LACK OF HAVING SOMEBODY TRIP OVER A CRACK IN THE 

13 SIDEWALK, THIS WOULD HAVE GONE UNNOTICED. BUT MAYBE HIS 

14 PROBLEM, THIS GENTLEMAN WHO WAS MISAPPROPRIATING THE FUNDS, 

15 MAYBE HIS PROBLEM WAS HE SHOULD HAVE KEPT THREE SETS OF BOOKS 

16 LIKE THEY DO AT METRO. I DON'T KNOW IF IT'S ACOUSTICS HERE, 

17 BUT I COULD HAVE SWORN, MS. MOLINA, YOU SAID HE WAS A LAWYER. 

18 I DON'T KNOW, MUST BE THE ACOUSTICS. D.C.F.S., THE PROBLEMS, 

19 YOU HAD CONTROL OF IT, YOU GAVE THEM OVER TO THE CHIEF 

20 EXECUTIVE OFFICER, NOW YOU TOOK THEM BACK AGAIN AS THE 

21 OVERSEER OF THE DEPARTMENTS. I'M WAITING, I'D LIKE TO SEE A 

22 LIST OF IMPROVEMENTS COME OUT AND CHANGES NOW THAT YOU'RE 

23 RETAKING THE LEADERSHIP OF THOSE DEPARTMENTS BETWEEN D.C.F.S. 

24 AND PROBATION. IT SHOULD BE VERY INTERESTING. THANK YOU. 

25



June 7, 2011

41

1 SUP. ANTONOVICH, MAYOR: CAN WE HAVE A REPORT BACK NEXT WEEK 

2 WHEN THIS ACTIVITY IS GOING ON, ON, HOW LONG THE SUSPECT, OR 

3 WE HAD SUSPECTED THIS ACTIVITY OF FRAUD HAD BEEN TAKING PLACE. 

4 WHEN DID WE FIRST BELIEVE THERE WAS A FRAUDULENT ACTIVITY 

5 TAKING PLACE UNDER THIS PERSON'S DIRECTION? TWO, IF THE 

6 EMPLOYEE HAD NOT PASSED AWAY, WHAT OTHER MECHANISMS WERE IN 

7 PLACE THAT COULD ULTIMATELY TRIGGER AN AWARENESS OF THIS FRAUD 

8 THAT WAS TAKING PLACE? AND WHY THE BOARD WAS NOT NOTIFIED 

9 IMMEDIATELY WHEN THIS WAS BEING DETECTED, WHY THAT INFORMATION 

10 WAS KEPT BY THE BOARD OF SUPERVISORS AND WHO DID THAT. AND IF 

11 WE COULD HAVE THAT INCLUDED BACK IN THE REPORT FOR NEXT WEEK 

12 BY THE C.E.O. AND THE DEPARTMENT. SO MOVED. SECONDED BY 

13 SUPERVISOR MOLINA. WITHOUT OBJECTION, SO ORDERED. DO YOU HAVE 

14 ANY ADJOURNMENTS GLORIA? 

15

16 SUP. MOLINA: I'D LIKE TO ASK THAT WE ADJOURN IN MEMORY OF THE 

17 PRESTIGIOUS LOCAL PLANNER, DAVID A. WILCOX. THROUGHOUT HIS 

18 DISTINGUISHED CAREER, DAVID CONTRIBUTED NUMEROUS LOCAL 

19 PROJECTS, INCLUDING THE ICONIC WHITTIER BOULEVARD ARCH IN EAST 

20 LOS ANGELES AND THE 1984 SUMMER OLYMPICS IN LOS ANGELES. HE 

21 WON NUMEROUS AWARDS FOR HIS ACCOMPLISHMENT OVER THE YEARS AND 

22 WAS ALSO A WELL KNOWN TEACHER AS WELL AS A MENTOR. WE WANT TO 

23 EXTEND OUR CONDOLENCES TO HIS FAMILY, HIS FRIENDS, AS WELL AS 

24 HIS COLLEAGUES. I'D ALSO ASK THAT ALL MEMBERS ADJOURN IN THE 

25 MEMORY OF EDWIN -- DID YOU DO THIS ONE, KWOH? 
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1

2 SUP. ANTONOVICH, MAYOR: EDDIE TANAKA? 

3

4 SUP. MOLINA: NO. EDWIN KWOH. HE IS THE BELOVED FATHER OF 

5 STUART KWOH. 

6

7 SUP. KNABE: ALL MEMBERS. 

8

9 SUP. MOLINA: THE EXECUTIVE DIRECTOR OF THE ASIAN PACIFIC 

10 AMERICAN LEGAL CENTER KNOWN AS A.P.A.L.C. EDWIN KWOH WAS A 

11 DISTINGUISHED COMMUNITY LEADER AND BUSINESSMAN. HE SERVED ON 

12 THE EXECUTIVE ADVISORY COMMITTEE OF THE A.P.A.L.C. AND HE WAS 

13 ALSO A LONG-STANDING MEMBER OF THE EAST-WEST PLAYERS COUNCIL 

14 OF GOVERNORS. HIS HUMANITARIAN AND CIVIC CONTRIBUTIONS WERE 

15 EXTENSIVE AND WELL KNOWN AND WE EXTEND OUR DEEPEST CONDOLENCES 

16 TO HIS FAMILY, FRIENDS AND HIS ADMIRERS, AND THANK HIM FOR HIS 

17 TREMENDOUS LEADERSHIP TO OUR COMMUNITY. ALL MEMBERS. 

18

19 SUP. ANTONOVICH, MAYOR: ALL MEMBERS. SECOND WITHOUT OBJECTION. 

20 SO ORDERED. 

21

22 SUP. MOLINA: I ALSO WOULD LIKE TO ASK THAT ALL MEMBERS JOIN 

23 WITH ME IN MEMORY OF VINNEL MASARU PAZ, A FIRST DISTRICT 

24 RESIDENT AND AN INFECTION CONTROL NURSE WITH THE LOS ANGELES 

25 COUNTY SHERIFF'S DEPARTMENT CORRECTIONAL TREATMENT CENTER. 
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1 VINNEL WAS A LONG-STANDING AND DEVOTED MEMBER OF THE COUNTY 

2 FAMILY. WE WANT TO EXTEND OUR THOUGHTS AND PRAYERS TO HIS 

3 FAMILY, HIS FRIENDS, AS WELL AS HIS COLLEAGUES. AND I'D LIKE 

4 ALL MEMBERS ON THAT, AS WELL. 

5

6 SUP. ANTONOVICH, MAYOR: SECOND, WITHOUT OBJECTION, SO ORDERED. 

7

8 SUP. MOLINA: THANK YOU. 

9

10 SUP. ANTONOVICH, MAYOR: DO YOU HAVE ANY ADJOURNMENT MOTIONS? 

11

12 SUP. RIDLEY-THOMAS: MR. MAYOR AND COLLEAGUES, WOULD YOU JOIN 

13 ME IN ADJOURNING IN MEMORY OF MICHAEL D. WILLIAMS, BORN APRIL 

14 24, 1950, IN THE CITY OF LOS ANGELES. HE PASSED ON MAY 14 AT 

15 THE AGE OF 61 HE WAS RAISED AND EDUCATED IN THE LOS ANGELES 

16 UNIFIED SCHOOL DISTRICT AND GRADUATED FROM MANUAL ARTS HIGH 

17 SCHOOL IN 1968. HE THEN GRADUATED FROM CAL STATE UNIVERSITY AT 

18 LOS ANGELES WITH A BACHELOR OF ARTS DEGREE IN 1984. HE THEN 

19 TOOK HIS TALENTS TO WORK FOR THE CITY OF SOUTH GATE FOR THE 

20 NEXT 13 YEARS AS AN ASSISTANT ENGINEER AND PUBLIC WORKS 

21 INSPECTOR. THE LAST 17 YEARS, HE WORKED AS A SPORTS 

22 CONSULTANT. MICHAEL WILL BE REMEMBERED AS A LOVING AND CARING 

23 PERSON AND AN AVID SPORTS FAN. HE IS SURVIVED BY HIS DAUGHTER, 

24 CLARITA; HIS SON, CYREL; HIS BROTHER, HAROLD, THE FORMER CITY 

25 COUNCILMEMBER IN THE CITY OF CARSON; HIS SISTERS, ROSE, 
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1 GERALDINE, AND HOPE; HIS GRANDDAUGHTER, NADIA; AND A NUMBER OF 

2 FAMILY AND FRIENDS WHO WILL ALSO REMEMBER HIM FONDLY. AND THEN 

3 MR. MAYOR WITH YOUR PERMISSION, I'D LIKE TO READ IN A MOTION 

4 AMENDMENT, A FRIENDLY AMENDMENT TO ITEM NO. 24 WITH YOUR 

5 PERMISSION. SUPERVISOR MOLINA HAS PUT FORTH A MOTION THAT I 

6 THINK IS VERY, VERY USEFUL AND THAT WE SHOULD ALL BE CONCERNED 

7 ABOUT. IT IS THE TIMELY DELIVERY OF SERVICE COORDINATION FOR 

8 PROBATION YOUTH. SO IN ADDITION TO THE MAIN MOTION THAT SHE 

9 HAS ENTERED, I'D JUST LIKE TO ASK THAT THE BOARD ADOPT 

10 RECOMMENDATIONS THAT ARE OUTLINED IN THE MOLINA MOTION AND 

11 INCLUDE THE FOLLOWING AMENDMENT WHICH WOULD ENSURE THE 

12 MULTIDISCIPLINARY TEAM, MEANING THE M.D.T., THAT IT IS 

13 SCHEDULED FAR ENOUGH IN ADVANCE OF THE MINOR'S RELEASE FOR A 

14 PROMPT AND SEAMLESS TRANSITION TO COMMUNITY SERVICE PROVIDERS 

15 AND INCLUDE THE MINOR'S PARENTS OR LEGAL GUARDIANS IN THE 

16 M.D.T. MEETING AND TRANSITION PLANNING. THIS I BELIEVE IS A 

17 SIGNIFICANT EFFORT ON THE PART OF SUPERVISOR MOLINA TO MAKE 

18 THE TRANSITION BACK INTO THE COMMUNITIES THAT ALL OF US ARE 

19 CONCERNED ABOUT IN SUCH A WAY THAT WE ENSURE A HIGHER LEVEL OF 

20 SUCCESS. THERE IS NO DEBATE IN MY MIND AND IN FEW OTHERS ABOUT 

21 THE LEVEL RECIDIVISM. BUT WHEN YOUNGSTERS ARE IN NEED OF THE 

22 APPROPRIATE MEDICATIONS AND THE LIKE, WHEN THEY DON'T HAVE 

23 THAT SUPPORT, WHEN THEY DON'T HAVE SUFFICIENT PARENTAL AND/OR 

24 FAMILIAL SUPPORT TO WORK BACK INTO THE COMMUNITIES, IT IS 

25 ESSENTIALLY A RECIPE FOR FAILURE AND/OR A REVOLVING DOOR. AND 
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1 I KNOW THAT ALL OF US HAVE BEEN CONCERNED ABOUT THIS. IT SEEMS 

2 TO ME THIS IS FUNDAMENTALLY IMPORTANT AND I WANT TO 

3 ACKNOWLEDGE SUPERVISOR MOLINA'S LEADERSHIP ON THIS AND OFFER 

4 THIS FRIENDLY AMENDMENT. 

5

6 SUP. ANTONOVICH, MAYOR: LET ME SECOND THAT. WE HAVE ARNOLD 

7 SACHS. 

8

9 ARNOLD SACHS: THANK YOU. THIS ITEM WAS 24. OH. YES MA'AM. 

10 HERE'S MY CONCERNS REGARDING THIS. YOU'VE TAKEN NUMEROUS 

11 OPPORTUNITIES, I BELIEVE, THE C.E.O. HAS CHECKED WITH OTHER 

12 CITIES AND SOME OF THE POLICIES THROUGHOUT THE COUNTRY THAT 

13 THE HIRING OF THE 27 MENTAL HEALTH PROFESSIONALS IS JUST 

14 OCCURRING NOW FOR THE -- IS THAT INCLUSIVE OF OTHER MENTAL 

15 HEALTH PROFESSIONALS THAT ARE ALREADY ON STAFF TO BRING THE 

16 TOTAL UP TO A STANDING AMOUNT OF WHAT? THAT'S NOT IN THE 

17 REPORT HERE. OR IS THIS JUST A BRAND NEW HIRE OF 27 MENTAL 

18 HEALTH PROFESSIONALS, AND THAT THIS IS A BRAND NEW PROGRAM 

19 THAT'S GOING TO BE STARTED UNDER THE DIRECTOR OF MENTAL HEALTH 

20 IN THE CHIEF PROBATIONS OFFICER. BECAUSE IT'S JUST SUCH AN 

21 OUTSTANDING PROBLEM TO HAVE IN THE COUNTY AND HAVE THESE 

22 PROBLEMS THAT IT WOULD TAKE SO LONG TO DISCOVER THIS AS AN 

23 OPTION. THANK YOU. 

24
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1 SUP. ANTONOVICH, MAYOR: THANK YOU. OKAY. MOTION BY SUPERVISOR 

2 RIDLEY-THOMAS. SECONDED BY SUPERVISOR MOLINA. WITHOUT 

3 OBJECTION AS AMENDED SO ORDERED. OKAY. MR. SACHS, 2-D, 1-H, 4, 

4 25, 31, 33, 37, 40 AND 62-C. 

5

6 ARNOLD SACHS: YES, THANK YOU AGAIN. 2-D. I HELD THIS ITEM, I 

7 WOULD HAVE HELD 1-H ALSO. THIS IS BECAUSE OF SOME OF THE 

8 LANGUAGE IN IT. IT'S A MODEL DEVELOPED, THERE'S A PART OF IT 

9 SAYS THERE'S AN EXTERNAL AUDIT TOOK PLACE IN APRIL OF 2002 AND 

10 MODEL DEVELOPED IN CONJUNCTION WITH THAT EXTERNAL AUDIT. AND 

11 SO I'M WONDERING, BECAUSE THIS IS THE COMMUNITY DEVELOPMENT, 

12 BACK IN MAY 24, PART OF YOUR C.D.B.G. ACTION PLAN, AND I USE 

13 THE WORD ACTION PLAN AS PART OF YOUR AGENDA, YOU WERE USING 

14 ALMOST $12 MILLION OF FUNDS -- ALMOST $14 MILLION OF 

15 UNEXPENDED C.D.B.G. FUNDS FROM PRIOR YEARS. SO HERE YOU HAVE 

16 AN EXTERNAL AUDIT AND THIS MODEL DEVELOPED AUDIT TAKING PLACE 

17 IN APRIL OF 2002. THIS IS 2011 GOING CLOSE TO 2012 WITH THE 

18 ECONOMY BEING IN FLUX THE WAY IT'S BEEN, IS IT TIME TO MAYBE 

19 RECHECK THAT MODEL DEVELOPED IN CONJUNCTION WITH THAT AUDIT? 

20 THAT'S THAT. ITEM 4 I HELD BECAUSE OF SOME OF THE LANGUAGE IN 

21 IT THAT PERTAINS TO THE CHIEF EXECUTIVE OFFICE RECOMMENDS THAT 

22 THE SUPERINTENDENT OF SCHOOLS MEET REGULARLY WITH THE BOARD OF 

23 SUPERVISORS AND THE CONTRACT STATES THAT THE SUPERINTENDENT OF 

24 SCHOOLS WILL SET REGULAR MEETINGS WITH THE BOARD OF DEPUTIES. 

25 JEEPERS. HERE'S REGULAR MEETINGS, I HAVE AN AGENDA FROM METRO 
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1 REGULAR MEETINGS FOR THE GOLD LINE CONSTRUCTION AUTHORITY. BUT 

2 IT'S NOT A LEGAL ENTITY. SO WHAT THE HECK DOES THAT MEAN IF 

3 YOU SET REGULAR MEETINGS AND YOU DON'T HAVE A LEGAL ENTITY? 

4 IT'S NOT A GOVERNMENT AGENCY, WHOOP-DI-DO. ITEM NO. 31? 25? 

5

6 SUP. ANTONOVICH, MAYOR: 25, 31. 

7

8 ARNOLD SACHS: ALL RIGHT. 31 AND 25 I HELD ONLY IN CONJUNCTION 

9 WITH -- NO. NOT THE GOLD LINE, SIR. 

10

11 SUP. ANTONOVICH, MAYOR: THE BLUE LINE. 

12

13 ARNOLD SACHS: WELL THE CITY OF L.A. JUST PASSED AN ORDINANCE 

14 ELIMINATING HOUSING OR LIMITING HOUSING FOR CARE PROGRAMS. AND 

15 I WAS WONDERING IF THIS WOULD HAVE ANY EFFECT ON MONEY AND 

16 FUNDING AND LOCATIONS DUE TO THE CONSTRAINTS THAT HAVE BEEN 

17 PLACED BY THE CITY OF L.A. ITEM NO. 33? OH. THIS IS GOLD LINE, 

18 SIR. TAX RATE. PER PARCEL. HERE'S AN ITEM RECORDED AT THE 

19 COUNTY REGISTRAR'S OFFICE FOR A LAND EASEMENT. WOULD THIS ALSO 

20 BE UNDER THE INFLUENCE OF A TAX RATE BECAUSE IT'S A PARCEL OF 

21 AN EASEMENT? AND WHO'S RECORDING THIS? THE LOS ANGELES TO 

22 PASADENA METRO BLUE LINE CONSTRUCTION AUTHORITY. NOT A LEGAL 

23 ENTITY. SO WHY ARE THEY ON THE DOCUMENT? MAYBE THAT'S THEIR 

24 PRIVATE PROPERTY. HOW DID THEY GET HOLD OF IT? IT WAS BOUGHT 

25 THROUGH PUBLIC FUNDS FOR THE GOLD LINE EXTENSION. IT'S 
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1 WONDERFUL HOW TWO SETS OF BOOKS WORK SOMETIMES. ITEM 37 I HELD 

2 OR ITEM 33 I HELD, IT WAS THE TAX RATE. AGAIN, L.A. ALSO HAS A 

3 BIG BUSINESS IMPROVEMENT DISTRICT WHERE GOVERNMENT ENTITIES 

4 ARE TAXED, ARE CONSIDERED PART OF THE BID. I WAS WONDERING 

5 AGAIN WITH THIS PARCEL. THE FUNDING FOR MAX, SUPERVISOR KNABE, 

6 YOU KNOW THAT PALOS VERDES DROPPED OUT OF MAX. WOULD THAT 

7 INCLUDE A CHANGE IN THE ROUTE? OR OTHER CITIES IN THE SOUTH 

8 BAY OTHER THAN TORRANCE? MAYBE EVEN REDONDO? 

9

10 SUP. KNABE: NO. ALL THE CHANGES TRUNCATED TORRANCE. IT WON'T 

11 INCLUDE THE HILL. 

12

13 ARNOLD SACHS: AND ITEM 40, SACHI? ITEM 40? AGAIN, AN EASEMENT 

14 REGISTERED WITH THE COUNTY REGISTRAR'S RECORDER OFFICE. I 

15 WONDER IS THERE A VIOLATION IF YOU ILLEGALLY USE A NAME ON A 

16 FORM TO REGISTER PROPERTY, IS THERE SOME KIND OF LEGAL 

17 RECOURSE THAT COULD BE TAKEN? JUST OUT OF CURIOSITY. AND ITEM 

18 62-C? THIS IS THE DEVIL'S GATE. WILL THE COUNTY BE INDEMNIFIED 

19 IN CASE THERE'S A MAJOR DISASTER IF THERE'S NOT ENOUGH FILL 

20 TAKEN, REMOVED FROM THIS PROPERTY, FROM THIS AREA, IF THERE'S 

21 A MAJOR DISASTER THAT OCCURS THAT IT CAUSES, WHO KNOWS, A 

22 MASSIVE LANDSLIDE THAT AFFECTS THIS AREA AND CAUSES RUNOFF OR 

23 SPILLAGE OR INCREASES, LISTEN, THE NUCLEAR PLANT IN JAPAN WAS 

24 BUILT TO LAST -- BUILT TO SUSTAIN DAMAGE FROM A TSUNAMI. BUT 

25 NOT THE TSUNAMI THAT OCCURRED. SO THERE'S NO TELLING WHAT 
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1 NATURE CAN DO. WHAT HAPPENS IF THIS DEVIL'S GATE FAILS TO THE 

2 PROPERTY DOWN SOUTH OF THE BARRIER? WHO'S ON THE HOOK FOR 

3 THAT? THANK YOU. 

4

5 SUP. ANTONOVICH, MAYOR: OKAY. ITEM 2-D, 1-H, 4, 25, 31, 33, 

6 37, 40, 62-C, WITH ME ABSTAINING ON 33, MOTION BY SUPERVISOR 

7 MOLINA, SECONDED BY SUPERVISOR KNABE. WITHOUT OBJECTION, SO 

8 ORDERED. DOES SUPERVISOR YAROSLAVSKY HAVE ANY ADJOURNMENT 

9 MOTIONS? SUPERVISOR MARK RIDLEY-THOMAS YOU HAD NO. 3? 

10

11 SUP. RIDLEY-THOMAS: THANK YOU, MR. MAYOR. I THINK THE IDEA WAS 

12 TO CONTINUE ITEM NO. 3 FOR ONE WEEK, AT WHICH TIME THE 

13 OUTSTANDING ISSUES, I CAN ASSURE YOU, WILL BE RESOLVED TO OUR 

14 COLLECTIVE SATISFACTION, AT LEAST TO THE MAJORITY OF US, AT 

15 WHICH TIME WE WILL DISPOSE OF THE MATTER. 

16

17 SUP. ANTONOVICH, MAYOR: OKAY. SO DO YOU WANT TO MOVE IT? 

18

19 SUP. RIDLEY-THOMAS: ONE WEEK CONTINUANCE. 

20

21 SUP. ANTONOVICH, MAYOR: ONE WEEK TO CONTINUE, BY SUPERVISOR 

22 MARK RIDLEY-THOMAS, SECOND WITHOUT OBJECTION, SO ORDERED. MR. 

23 JONES? 

24
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1 EDDIE JONES: ITEM NO. 13? WELL, I THINK EARLIER THE STATEMENT 

2 WAS THAT ALL FUNDS THAT ARE BEING ALLOCATED TO DEPARTMENT OF 

3 CHILDREN AND FAMILY SERVICES RIGHT NOW SHOULD GO INTO MAKING 

4 SURE YOU HAVE THE RIGHT LEADERSHIP, THE RIGHT MOTIVATION, THE 

5 RIGHT INTEGRITY, THE RIGHT DIGNITY, THE RIGHT DISCIPLINE, 

6 SOCIAL SKILLS, ETIQUETTE, SELF-RESPECT AND SELF-LOVE FOR THESE 

7 FOSTER CHILDREN. AS YOU WELL KNOW IN THE PAST, ONE OF THE 

8 BIGGEST THINGS THAT FACES THE FOSTER CARE SYSTEM WAS SO MANY 

9 KIDS DIED IN THE FOSTER CARE SYSTEM IN THE LAST THREE OR FOUR 

10 YEARS. AND I'VE READ ALL THOSE CASES. WE WANT TO MAKE SURE 

11 THEY HAVE THE PROPER HOUSING, THE PROPER PARENTING AND THEY 

12 CAN LEARN ETIQUETTE AND SOCIAL SKILLS AND LEARN HOW TO GET OUT 

13 THERE IN LIFE AND DO SOMETHING PRODUCTIVE AND POSITIVE FOR 

14 THEMSELVES. BUT THE MOST IMPORTANT THING IS THAT THEY'RE NOT 

15 FAILED BY THE SYSTEM. AND SO I PRAY THAT THIS DOESN'T FALL ON 

16 DEAF EARS, THAT IT FALLS ON EARS WHO HAVE MAJOR CONCERNS ABOUT 

17 THE WELL-BEING OF THE SYSTEM, WHETHER IT HAS RED TAPE, BLUE 

18 TAPE, GREEN TAPE AND ALL KINDS OF TAPE BEFORE WE CAN GET TO 

19 HELPING THESE YOUTH AND YOUNG PEOPLE WHO HAVE BEEN MISPLACED 

20 IN OUR SOCIETY. AND NOW THAT THE COUNTY HAS TAKEN ON THE JOB 

21 OF REVAMPING ITS DEPARTMENT OF CHILDREN AND FAMILY SOCIAL 

22 SERVICES, I JUST WANT TO BE A PART, IF YOU WOULD LIKE ANY 

23 ADVICE WHATSOEVER FROM A CIVIL STANDPOINT, I HOPE THAT -- I 

24 WANT TO LEAVE MY CARD HERE FOR EACH MEMBER OF THE BOARD TO 

25 PLEASE REACH OUT TO ME BECAUSE THE COMMUNITY CALLS ME. THEY 
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1 EMAIL ME. THEY TALK TO ME ABOUT THEIR CONCERNS. AND RIGHT NOW, 

2 THE MAJOR THING THAT'S GOING AROUND THE WHOLE SYSTEM IS THE 

3 DEPARTMENT OF CHILDREN AND FAMILY SOCIAL SERVICES. THAT IS THE 

4 MOST MAJOR DISCUSSION IN OUR COMMUNITY AT THIS TIME. THANK YOU 

5 VERY MUCH. AND I'LL PASS ON 14. THANK YOU VERY MUCH. 

6

7 SUP. ANTONOVICH, MAYOR: ALSO ON 14? 

8

9 EDDIE JONES: I'M GOING TO PASS ON 14. THANK YOU. 

10

11 SUP. ANTONOVICH, MAYOR: OKAY. NAGI ELHADARY ON 8, 13, 14 AND 

12 CS-3. 

13

14 NAGI ELHADARY: ALL RIGHT. MY NAME IS NAGI ELHADARY, THAT'S N-

15 A-G-I E-L-H-A-D-A-R-Y. I'M HERE OPPOSING ANY FUNDS THAT OUR 

16 FEDERAL GOVERNMENT GIVE OR WORK WITH D.C.F.S. HERE IN LOS 

17 ANGELES. MY SON TINO WAS WRONGFULLY TAKEN BY A D.C.F.S. WORKER 

18 HERE IN LOS ANGELES THAT WAS TERMINATED FOR TAKING MY SON 

19 WRONGFULLY. I TOOK THIS CASE IMMEDIATELY TO ZEV YAROSLAVSKY'S 

20 OFFICE. I SPOKE NUMEROUS TIMES WITH AN INVESTIGATOR THERE IN 

21 CHARGE WITH THE MATTER, REGINA MARQUEZ AND OTHER PEOPLE IN HIS 

22 OFFICE WHO JUST DISREGARDED IT AND WIPED IT UNDER THE RUG. I 

23 SPOKE WITH ANDREA ORDIN IN PERSON, THE CRIMINAL SHE IS, THAT 

24 TOLD ME SHE WOULD GET MY SON BACK TO ME WITHIN THE FIRST TWO 

25 MONTHS HE WAS TAKEN. IT'S BEEN OVER A YEAR, MS. ORDIN. MY SON 
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1 WANTS TO COME HOME, TINO WANTS TO COME HOME, MS. ORDIN. I'M 

2 DEMAND TO SPEAK TO A JACKIE CONTRERAS FROM D.C.F.S., ANTONIO 

3 VICKS, THERE, THE CRIMINAL HE IS HAS TRIED TO HIDE HER AND 

4 PROTECT HER FROM MEETING WITH ME LIKE HE HAD ME MET WITH 

5 ANTONIA JIMINEZ, WHO STEPPED DOWN FROM D.C.F.S. BECAUSE 

6 ANTONOVICH ASKED HER NOT TO TOUCH ABOUT MY CASE IN PUBLIC. 

7 ANTONOVICH, YOU ARE A CRIMINAL. TINO WANTS TO COME HOME. HOW 

8 DO YOU LOOK AT YOUR KIDS -- HOW DO YOU LOOK AT YOUR KIDS, 

9 ANTONOVICH? MY SON WOULD LIKE TO COME HOME. YOU ARE A 

10 CRIMINAL. STEP DOWN AND RETURN MY SON. OUR FEDERAL GOVERNMENT, 

11 PLEASE SET UP A GRAND JURY TO PUT THESE CRIMINALS ON THE 

12 STAND, THE CRIMINALS BEING ORDIN, ANTONOVICH, MOLINA, 

13 YAROSLAVSKY AND JACKIE CONTRERAS FROM D.C.F.S. SENDING ALDO 

14 MARIN TO SPEAK WITH ME INSTEAD OF SPEAKING WITH ME HERSELF. MY 

15 SON WOULD LIKE TO COME HOME. I'D LIKE TO PROPOSE AN AGENDA BE 

16 SET UP IN REGARDS TO TINO COMING HOME AND THE REVAMPING AND 

17 REDOING OF D.C.F.S. IN TOTAL. MS. ORDIN, HOW DO YOU LOOK AT 

18 YOUR CHILDREN? MY SON WOULD LIKE TO COME HOME. HIS NAME IS 

19 TINO. DO YOU CARE? OR DO YOU LIKE STANDING IN THE CORNER THERE 

20 LAUGHING? ORDIN, YOU ARE A CRIMINAL. I'D LIKE TO NOW SPEAK ON 

21 AGENDA 14. 

22

23 SUP. ANTONOVICH, MAYOR: OKAY. YOUR TIME IS UP ON 8, 13, 14 AND 

24 62-B. SO WE HAVE MOTIONS TO MOVE SECONDED BY SUPERVISOR 
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1 MOLINA, WITHOUT OBJECTION, SO ORDERED. SUPERVISOR KNABE HAS A 

2 MOTION TO READ IN. 

3

4 SUP. KNABE: MR. MAYOR, MEMBERS OF THE BOARD, THIS IS A MOTION 

5 FROM MYSELF AND SUPERVISOR YAROSLAVSKY. THE TRAGEDY OF THE 

6 JAPANESE EARTHQUAKE AND ITS SUBSEQUENT DEVASTATING TSUNAMI WAS 

7 A SEVERE WAKEUP CALL FOR US ALL TO EXAMINE OUR OWN RISKS AND 

8 PREPARE FOR A SIMILAR EVENT HAPPENING HERE ON THE COASTLINE. 

9 ON MARCH 29, 2011, THE BOARD INSTRUCTED THE C.E.O., OFFICE OF 

10 EMERGENCY MANAGEMENT TO REPORT BACK ON THE ADVISABILITY AND 

11 FEASIBILITY OF DEVELOPING AN ADDITIONAL LEVEL OF MASS 

12 NOTIFICATION TSUNAMI EMERGENCY SIREN WARNING SYSTEM TO THE 

13 COUNTY'S EXISTING MASS NOTIFICATION WARNING SYSTEM. THE REPORT 

14 WAS SUBMITTED TO THE BOARD OFFICES ON MAY 18 AND CONSISTS OF 

15 RECOMMENDATIONS FORMULATED BY A WORKGROUP OF REPRESENTATIVES 

16 FROM O.E.M., OUR SHERIFF'S DEPARTMENT, OUR COUNTY FIRE 

17 DEPARTMENT, OUR DEPARTMENT OF BEACHES AND HARBORS AND THE 

18 DEPARTMENT OF PUBLIC WORKS. THIS WORKGROUP INVESTIGATED AND 

19 ANALYZED CONVENTIONAL SIREN OPERATIONS, SIREN ACTIVATION AND 

20 THE FINDINGS OF A MASS NOTIFICATION SIREN WARNING SYSTEM TEST 

21 CONDUCTED BY OUR SHERIFF IN 2007 IN MARINA DEL REY. THEY ALSO 

22 REPORTED THAT CAL EMA IS CURRENTLY CONDUCTING A SURVEY OF ALL 

23 CALIFORNIA COASTAL AREA OPERATIONAL AREAS ON THE USE OF SIREN 

24 WARNING SYSTEMS. BASED ON THEIR INVESTIGATION, THE WORKGROUP 

25 RECOMMENDS THE ADVISABILITY AND FEASIBILITY OF DEVELOPING A 
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1 TSUNAMI EMERGENCY SIREN WARNING SYSTEM, WHICH REQUIRES AN 

2 EVALUATION BY SUBJECT MATTER EXPERTS IN THE FIELDS OF SIREN 

3 SYSTEMS, ACOUSTICAL REQUIREMENTS, ENVIRONMENTAL IMPACT STUDY 

4 REQUIREMENTS AND ELECTRONIC WARNING SYSTEMS OPERATIONS IN 

5 ORDER TO ASSESS AND DETERMINE THE ACTUAL COST OF PLANNING, 

6 DEPLOYING AND MAINTAINING SUCH A SYSTEM. THIS EVALUATION 

7 SHOULD ALSO INCLUDE A COST BREAKDOWN AND COMPARISON FOR THE 

8 DEPLOYMENT OF A SIREN WARNING SYSTEM FOR EITHER THE 

9 UNINCORPORATED COUNTY COASTAL AREAS OR DEPLOYING ALONG THE 

10 ENTIRE L.A. COUNTY COASTLINE. WE THEREFORE MOVE THAT UPON 

11 COMPLETION OF CAL EMA'S SURVEY, THE C.E.O. OR O.E.M. PROCEED 

12 WITH AN EVALUATION BY OUR SUBJECT MATTER EXPERTS AND REPORT 

13 BACK TO THE BOARD THE RESULTS OF THE EVALUATION, INCLUDING THE 

14 ESTIMATED COSTS AND SCOPE OF A PROJECT, ALONG WITH IDENTIFYING 

15 POTENTIAL FUNDING SOURCES TO IMPLEMENT OUR TSUNAMI EMERGENCY 

16 SIREN WARNING SYSTEM HERE IN LOS ANGELES COUNTY. AND I BELIEVE 

17 SINCE IT'S A REPORT BACK, WE CAN ACT ON IT TODAY. 

18

19 SUP. ANTONOVICH, MAYOR: MOTION BY SUPERVISOR KNABE. SECONDED 

20 WITHOUT OBJECTION FOR REPORT BACK, SO ORDERED. 

21

22 SUP. KNABE: THAT'S ALL I HAVE. 

23

24 SUP. ANTONOVICH, MAYOR: ANY OF YOU HAVE ANY OTHER MOTIONS? 

25 WE'LL GO ON TO PUBLIC COMMENT NOW. OKAY. IS TIFFANY FOSTER AND 
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1 EDDIE JONES? AND BOBBY COOPER? IRENE PANG? ARNOLD SACHS? AND 

2 NAGI ELHADARY. MR. COOPER, WELCOME BACK. 

3

4 BOBBY COOPER: HOW ARE YOU DOING TODAY, SIR? 

5

6 SUP. ANTONOVICH, MAYOR: PRETTY WELL. 

7

8 BOBBY COOPER: OKAY. I WANT YOU TO KNOW THAT I'M NOT HOSTILE 

9 TODAY. GOD HAS BLESSED ME. 

10

11 SUP. ANTONOVICH, MAYOR: YOU'RE NEVER HOSTILE. 

12

13 BOBBY COOPER: WELL I'M TRULY HERE IN PERSON. DIDN'T EXPECT TO 

14 BE. I WAS WONDERING WHO WON THE BET THAT I WOULDN'T BE HERE 

15 BECAUSE I'VE HAD. 

16

17 SUP. ANTONOVICH, MAYOR: YOU DIDN'T WEAR YOUR WHITE JACKET 

18 TODAY. 

19

20 BOBBY COOPER: PARDON? 

21

22 SUP. ANTONOVICH, MAYOR: YOU DIDN'T WEAR YOUR WHITE JACKET 

23 TODAY. 

24
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1 BOBBY COOPER: WELL GOD HAS PROVIDED ME WITH SUFFICIENT 

2 CLOTHING TODAY EVEN THOUGH WHOEVER STOLE MY CLOTHING, THE 

3 SOCIAL WORKERS THAT YOU HAD TO HELP ME HAD ME PUT OUT OF EVERY 

4 APARTMENT. TWO ATTEMPTS ON MY LIFE TO TAKE MY LIFE. YOU KNOW, 

5 USING LOS ANGELES POLICE DEPARTMENT EMPLOYEES. I'M HERE TODAY 

6 NOT TO ARGUE THAT POINT. I'M HERE TODAY BECAUSE THEY'RE 

7 HOLDING MY SOCIAL SECURITY MONEY. I HAVEN'T GOT MY I.R.S. TAX 

8 RETURNS OR ANYTHING. I'M HERE TODAY TO TRY TO GET MY MONEY OUT 

9 OF CHASE BANK, WHICH THE SOCIAL WORKERS ARE DEALING, I HAVE TO 

10 DEAL WITH THEY'RE CORRUPT AT THE, WHAT IS THAT? THE SOCIAL 

11 SECURITY OFFICE AND CHASE BANK. I'D LIKE TO HAVE AN ESCORT 

12 THERE TO WITNESS TO GET MY MONEY THERE, GIVING AWAY ACCOUNT 

13 NUMBERS OF MINE. THEY'VE GOT CREDIT CARDS I'VE HAD TO CANCEL 

14 AND CUT UP. I DON'T APPRECIATE THAT. I DON'T HAVE ENOUGH TIME 

15 TO EXPLAIN IT'S CORRUPT. I COULD TELL YOU ONE THING, THOUGH, 

16 THAT YOUR ATTORNEY THAT WAS LITIGATING THE CASE BC-419845 DID 

17 DEFAULT THAT CASE, YOU KNOW. AND ANOTHER CASE IN RIVERSIDE RC-

18 44462377 DEFAULTED THAT CASE. I'D APPRECIATE YOU HELP SOMEBODY 

19 GET ME A PLACE TO STAY TO WHERE I CAN DO THIS PROPERLY, I 

20 DON'T HAVE TO COME BEFORE THE BOARD MAKING THE ALLEGATIONS 

21 WITHOUT MERIT, WITHOUT PROOF AT PRESENT. I AM JUST LOOKING FOR 

22 SOMEONE TO HELP ME WITH MY HOUSING AT PRESENT. 

23

24 SUP. ANTONOVICH, MAYOR: THANK YOU, MR. COOPER. 

25



June 7, 2011

57

1 SUP. ANTONOVICH, MAYOR: THANK YOU. MISS PANG? 

2

3 IRENE PANG: HI, I'M IRENE PANG. I'D LIKE TO SAY I DO ANYTHING 

4 MY -- DAY, AS MYSELF EVERYTHING IS I CAN MYSELF AND ALSO 

5 EITHER THINGS INTO MY HEART AND ALSO HONEST AND IS MY 

6 CHARACTERISTIC. ALSO KEEP MY DIGNITY IS ALSO MY BIG 

7 CHARACTERISTIC. I HONEST PATIENT IS HANDLED E THING FOR THE 

8 PUBLIC ALL FOR ANYONE. AND I DON'T LIKE THOSE P.A. THE BATTERY 

9 OR OTHER INSULTING USING THE DIRTY, ALL THE UGLY AND THE KIND 

10 OF LANGUAGE YOU DID, OTHERS, AND TAKE ASSOCIATE ALL OTHERS. 

11 AND SOMETHING ELSE IN THIS KIND OF ATTEMPT TO -- THE ONE -- 

12 THE PUBLIC SAFETY. SECOND THING I CONCERNED ABOUT THE PUBLIC 

13 SAFETY IS REALLY IMPORTANT TO ALL THE CITIZENS IN THE NATION, 

14 SPECIAL GIRLS, DAY AND NIGHT THOSE IS DAY AND NIGHT IS TAKE 

15 THEIR CHANCE AND IN THE BUSINESS AREA ALL CALLS AND SAFE TO 

16 THE PUBLIC, THE SAFETY AND THE BUSINESS. THAT'S WHY I ALSO AM 

17 NOT EVEN CITIZEN AND GOVERNMENT -- TO PROTECT THE NATION AND 

18 THE CITIZEN. ALSO, I CONCERNED MY FAMILY MEMBERS' SAFETY AND 

19 INFLUENCE. THANK YOU. 

20

21 SUP. ANTONOVICH, MAYOR: THANK YOU, MS. PANG. BEFORE YOU SPEAK, 

22 LET ME JUST STATE FOR THE RECORD YOUR CASE IS IN A COURT OF 

23 LAW. THE SUPERVISORS HAVE NO CONTROL OVER THE SUPERIOR COURT. 

24 I UNDERSTAND IT'S BEEN APPEALED. AND UNTIL THE COURT RULES, 
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1 THEY HAVE FINAL JURISDICTION OVER THE CARE AND THE CUSTODY OF 

2 YOUR CHILD. SO RECKLESS CHARGES HERE HELP NO ONE. 

3

4 NAGI ELHADARY: WELL YOU'RE A LIAR, ESPECIALLY JIMINEZ, 

5 D.C.F.S. HAD JURISDICTION OVER THIS MATTER WHEN I MET WITH 

6 YOU, LIAR ANTONOVICH. THEN YOU HAD ANTONIO JIMINEZ TERMINATE 

7 JURISDICTION AND THEN THROW MY CASE IN THE FAMILY COURT. MR. 

8 ANTONOVICH, YOU PUT MY SON IN A PLACE WHERE HE IS IN DANGER 

9 RIGHT NOW. YOU NEED TO BE PUT IN PRISON. SO LET ME START. MY 

10 NAME IS NAGI ELHADARY. NAGI, LAST NAME, ELHADARY, TO OUR 

11 MEMBERS OF THE MEDIA, PUBLIC, LAW AND GOVERNMENT, PLEASE 

12 GOOGLE MY NAME SPACE D.C.F.S., YOU'LL SEE ALL THE CRIMES AND 

13 EVERYTHING THERE THAT HAS GONE ON IN MY CASE. I'D LIKE TO ASK 

14 SHERIFF WHEATCROFT HERE TO PLEASE PRESENT THESE DOCUMENTS TO 

15 THE BOARD AND CRIMINAL ORDIN AND FUJIOKA THERE WHO HAS BEEN 

16 NEGLIGENT IN NOT GETTING MY SON BACK TO ME. SHERIFF 

17 WHEATCROFT, PLEASE PRESENT IT TO THEM. WHEATCROFT PLEASE ALSO 

18 ONCE WE'RE DONE WITH THIS MEETING TAKE THESE CRIMINALS ON THE 

19 STAND IN CUSTODY. THAT IS YOUR JOB. ANTONOVICH, I'D LIKE MY 

20 SON BACK. WHAT WAS THE REASON MY SON WAS TAKEN? YOU KNOW ALL 

21 ABOUT MY CASE. YOU SENT THE D.C.F.S. WORKER MARILYN HYLES A 

22 LETTER ASKING HER TO LIE ON THE STAND AFTER SHE WAS FIRED. 

23 WE'D LIKE TO SET UP A GRAND JURY TO PUT YOU ON THE STAND AND 

24 ORDIN AND FUJIOKA AND YAROSLAVSKY AND RIDLEY-THOMAS. HE KNOWS 

25 ALL ABOUT MY CASE, WE TALKED ABOUT IT. ANTHONY SOMAD HAS 
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1 TALKED TO HIM ABOUT MY CASE. I'VE MET WITH EDDIE JONES WHO WAS 

2 HERE EARLIER AT NUMEROUS TIMES. HE'S STANDING UP BESIDE ME AND 

3 HELPING ME GET MY SON BACK, THANK GOD. YOU'RE A CRIMINAL, 

4 ANTONOVICH, QUIT THOSE LIES. HOW DO YOU LOOK AT YOUR KIDS IN 

5 THE MIRROR? HOW DO YOU LOOK AT YOUR KIDS? HOW DO YOU LOOK AT 

6 YOURSELF IN THE MIRROR? HOW DO YOU STEP UP THERE HOLDING THE 

7 DOGS EVERY TIME YOU COME UP IN THESE HEARINGS ON TUESDAYS 

8 ACTING LIKE YOU CARE ABOUT ANYBODY BESIDE YOURSELF AND MONEY? 

9 YOU'RE A PIECE OF GARBAGE. THESE ARE THE BOARD OF STUPID-

10 VISORS. PLEASE STEP DOWN AND RETURN MY SON TODAY. I DEMAND AN 

11 AGENDA BE SET UP IN REGARDS TO MY SON'S RETURN. 

12

13 SUP. RIDLEY-THOMAS: STRAIGHT OUT OF ORDER. 

14

15 SUP. ANTONOVICH, MAYOR: MR. SACHS? 

16

17 NAGI ELHADARY: ANDREA ORDIN, PLEASE RETURN MY SON. 

18

19 SUP. ANTONOVICH, MAYOR: MR. SACHS? 

20

21 ARNOLD SACHS: YES, THANK YOU. GOOD MORNING AGAIN, ARNOLD 

22 SACHS. I'D LIKE TO COMMENT ON YOUR MOTION THAT YOU MADE AT THE 

23 LAST S.C.A.G. MEETING, THE SOUTHERN CALIFORNIA ASSOCIATION OF 

24 GOVERNMENTS MEETING ABOUT THE HIGH SPEED RAIL. I FULLY 

25 APPRECIATE THE FACT THAT YOU'RE CONCERNED ABOUT THE FUNDING. 
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1 BUT ONE OF THE THINGS ALSO NOT DISCUSSED REGARDING HIGH SPEED 

2 RAIL IS THE NATURE OF THE INFRASTRUCTURE AFTER THE LINE IS 

3 BUILT, THE COST FOR THE TRAINS AND JUST BASED ON THE -- 

4

5 SUP. ANTONOVICH, MAYOR: THE OPERATION? 

6

7 ARNOLD SACHS: THE EXPERIENCE THAT WE NOTICE WITH METRO, THE 

8 FUNDING FOR RUNNING THE LINE ITSELF. NOTHING'S BEEN INCLUDED. 

9 ALL THIS FUNDING IS JUST ABOUT BUILDING THE TRACK 

10 INFRASTRUCTURE. SO WHERE DO WE GO FROM THEN AFTER YOU SPEND 

11 OVER 50 BILLION, MAYBE $60 BILLION IN THAT. IT'S A FIASCO THAT 

12 IS JUST -- IT'S INDESCRIBABLE. NOW, IN ANOTHER VEIN, BACK TO 

13 METRO, HERE'S A MOTION THAT WAS GIVEN TO ME FROM AUGUST 2005. 

14 THIS IS A MOTION BY DIRECTORS MOLINA, FASANA, ANTONOVICH, AND 

15 LOWENTHAL AS AMENDED BY DIRECTOR VILLARAIGOSA. WHEREAS 

16 EXISTING LAW ESTABLISHES THE LOS AGELESS TO PASADENA METRO 

17 BLUE LINE CONSTRUCTION AUTHORITY, NOW KNOWN AS THE METRO GOLD 

18 LINE FOOTHILL EXTENSION CONSTRUCTION AUTHORITY. STOP. THERE IS 

19 NO LAW. THIS IS THE COMPLETE BILL HISTORY GIVEN TO ME BY 

20 SUPERVISOR KNABE FOR A BILL NUMBER 1847. THE PASADENA METRO 

21 BLUE LINE CONSTRUCTION AUTHORITY. NO MENTION OF LOS ANGELES. 

22 NO MENTION OF THE GOLD LINE FOOTHILL EXTENSION CONSTRUCTION 

23 AUTHORITY. NO PART AT ALL. PLEASE EXPLAIN THE DIFFERENCE IN 

24 THE LANGUAGE WHEN YOU WERE SO CONCERNED ABOUT THE CRENSHAW 

25 LINE AND THAT LANGUAGE. THANK YOU. 
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1

2 SUP. ANTONOVICH, MAYOR: IS BEACHES AND HARBORS HERE? THE 

3 QUESTION THAT I HAVE, WAS ONE OF YOUR RECOMMENDATIONS TO 

4 CONSIDER THE OUTSOURCING OF CUSTODIAL AND MAINTENANCE 

5 SERVICES? 

6

7 SANTOS KREIMANN: SUPERVISOR, WE HAVE NOT MAKE THAT 

8 RECOMMENDATION TO OUTSOURCE THE CUSTODIAL SERVICES, NO. 

9

10 SUP. ANTONOVICH, MAYOR: AND WHY IS THAT? 

11

12 SANTOS KREIMANN: WELL, THE OUTSOURCING OF THE CUSTODIAL 

13 SERVICES WE DON'T BELIEVE WOULD BE APPROPRIATE ONLY BECAUSE 

14 THE TYPE OF WORK THAT OUR GENERAL MAINTENANCE CREWS DO ISN'T 

15 JUST ABOUT CLEANING RESTROOM FACILITIES. THEY ALSO HAVE 

16 LANDSCAPING RESPONSIBILITIES AND OTHER DUTIES INCLUDING 

17 CLEANING TRASH ON OUR TIDE LINES. AND SO IT WOULD BE VERY 

18 DIFFICULT AT THAT POINT IN TIME TO LET A CONTRACT OUT. THE 

19 OTHER REASON -- 

20

21 SUP. ANTONOVICH, MAYOR: BUT NO ONE IS DOING THE WORK, 

22 OBVIOUSLY THERE'S A PROBLEM THAT HAS TO BE FILLED. AND YOU 

23 HAVE OPTIONS OF PERHAPS A HYBRID SYSTEM WITH NIGHTTIME 

24 CLEANING OUTSOURCED WHILE KEEPING A SMALLER DAYTIME CREW THAT 

25 COULD HANDLE EMERGENCIES, LIGHT CLEANING AND SPECIAL EVENTS. 
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1 EACH DAY SOMEONE COULD CHECK ON THE WORK THAT WAS DONE THE 

2 NIGHT BEFORE. YOU HAVE THAT OPTION. YOU ALSO HAVE OPTIONS OF 

3 USING GENERAL RELIEF OR CUSTODIAL FROM THE LOCAL JAIL. ALSO 

4 WORKING WITH THE LOCAL POLICE DEPARTMENTS WHO HAVE PENAL 

5 FACILITIES WHERE THEY HAVE CUSTODIAL WORKERS WHO ARE SERVING 

6 THEIR TIME. YOU ALSO HAVE PERHAPS CONTRACTING WITH CAL TRANS 

7 FOR THOSE PEOPLE WHO ARE SERVING TIME FOR CLEAN THE FREEWAYS 

8 AND OTHER VENUES. I MEAN HAVING A PARTNERSHIP WITH THE STATE 

9 AND MAINTAINING THE CLEANLINESS OF THE BEACHES. BUT TO LEAVE 

10 THE FACILITIES IN SUCH A DEPLORABLE CONDITION IS IN MY OPINION 

11 THE WRONG APPROACH TO TAKE. WE NEED TO BE CREATIVE AND LOOK 

12 FOR ALL OPTIONS, BECAUSE CLEANLINESS OUGHT TO BE THE FIRST 

13 PRIORITY. 

14

15 SANTOS KREIMANN: I BELIEVE IN ANSWER TO YOUR QUESTION, BED' BE 

16 MORE THAN HAPPY TO TAKE A LOOK AT OTHER ALTERNATIVE CLEANING 

17 LABOR SOURCES. WE'VE ALSO BEEN USING, NOT GENERAL RELIEF 

18 WORKERS, BUT WE DID HAVE THE T.S.E. PROGRAM THAT WE TAPPED 

19 INTO LAST TWO SUMMERS. SO WE HAVE BEEN TRYING TO LOOK AT OTHER 

20 LABOR SOURCES. THE OTHER ISSUE THAT I WANT TO CLEAR UP, THERE 

21 HAS BEEN A LOT OF DISCUSSION ABOUT THE CLEANLINESS OF OUR 

22 FACILITIES AND WHETHER OR NOT THEY ARE IN A DEPLORABLE 

23 CONDITION. ONE OF THE REASONS THAT WE MADE THE SHIFT CHANGE IN 

24 THE EARLY MORNING SHIFT FROM 5 O'CLOCK IN THE MORNING TO 7 

25 O'CLOCK IN THE MORNING IS BECAUSE WE REALIZED THAT THE 
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1 MAJORITY OF THE PEOPLE THAT COME TO THE BEACH STAY LATER ON IN 

2 THE DAY. THEY COME IN THE AFTERNOON. MY STAFF WOULD BE ON THE 

3 BEACH FROM 5 O'CLOCK, CLEANING FACILITIES UNTIL 12:30, WHICH 

4 MEANT THAT THERE WAS NO CLEANING BEING DONE FROM 1:00 O'CLOCK 

5 ALL THE WAY UNTIL THE BEACH CLOSES. AND SO IN CHANGING OUR 

6 WORK SHIFT, AND I WANT TO MAKE IT VERY CLEAR, WE HAVE NEVER 

7 CLOSED ANY RESTROOM FACILITIES, WE'VE CONTINUED TO CLEAN THE 

8 FACILITIES AS IN THE PAST AS BEST WE POSSIBLY COULD WITH THE 

9 EXISTING RESOURCES THAT WE HAVE. WE HAVE, JUST LIKE EVERY 

10 OTHER COUNTY DEPARTMENT, SUFFERED SOME SIGNIFICANT BUDGET 

11 REDUCTIONS AND CURTAILMENTS THAT WE'VE ABSORBED. AND WE'VE 

12 ALWAYS TRIED TO CLEAN THE RESTROOM FACILITIES AND WE TAKE 

13 GREAT PRIDE IN DOING THAT. THE MAJORITY OF THE COMPLAINTS THAT 

14 HAVE COME TO OUR OFFICE HAVE NOT BEEN ABOUT THE CLEANLINESS OF 

15 THE FACILITIES. IT'S BEEN ABOUT OPENING THE RESTROOM 

16 FACILITIES EARLY IN THE MORNING AS A RESULT OF THAT SCHEDULE 

17 SHIFT. AND SO WHAT WE'VE DECIDED TO DO AND IN TERMS OF 

18 CONTRACTING OUT, WE DIDN'T LOOK AT THAT PARTICULAR OPTION 

19 BECAUSE WE BELIEVE WE HAVE A VERY GOOD PLAN MOVING FORWARD IN 

20 TERMS OF TRYING TO ATTRACT SOME TEMPORARY EMPLOYEES THAT WE'VE 

21 ALREADY STARTED GOING THROUGH THE PROCESS. AND SO WE HAD VERY 

22 LIMITED TIME TO COME UP WITH THIS PARTICULAR PLAN AND 

23 OUTSOURCING IT WOULD BE A LONGER PROCESS, I BELIEVE, THAN WHAT 

24 WOULD OCCUR IN THIS POINT IN TIME WITH THE PLAN THAT WE HAVE 

25 IN PLACE. SO THE CLEANLINESS OF THE FACILITIES, EVEN IF YOU 
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1 LOOKED AT THE NEWSCASTS OVER THE LAST WEEK, THE MAJORITY OF 

2 THE FOLKS THAT REPORTED SAID THAT THE FACILITIES WERE IN GOOD 

3 SHAPE. NOW, WE DON'T TAKE CARE OF THESE RESTROOM FACILITIES, 

4 THEY'RE NOT FIVE-STAR-HOTEL TYPE OF SERVICE THAT WE PROVIDE. 

5 THEY'RE PUBLIC RESTROOM FACILITIES THAT SERVICE MILLIONS AND 

6 MILLIONS OF PEOPLE EACH SUMMER. 

7

8 SUP. ANTONOVICH, MAYOR: SUPERVISOR KNABE, DO YOU HAVE ANY 

9 QUESTIONS? 

10

11 SUP. KNABE: NO. I JUST WANTED HIM TO GIVE HIS REPORT. I MEAN I 

12 THINK AT THE END OF THE DAY, I MEAN OUR ISSUE HERE IS THAT 

13 THERE HAS BEEN -- WE'RE NOT GOING TO JEOPARDIZE THE HEALTH OF 

14 THE RESIDENTS OF LOS ANGELES COUNTY AS WELL AS THE MANY 

15 MILLIONS OF VISITORS THAT WE HAVE ON OUR BEACHES EACH AND 

16 EVERY YEAR. IT'S JUST ONE OF THOSE ISSUES THAT WE HAVE TO DEAL 

17 WITH AND YOU HAVE TO DEAL WITH SPECIFICALLY IN YOUR BUDGET. 

18 IT'S NOT AN OPTION TO USE THAT AS A LOW-HANGING FRUIT TO 

19 SATISFY YOUR BUDGET NEEDS WHEN YOU HAVE THESE MILLIONS OF 

20 PEOPLE COMING TO THE BEACHES. AND AGAIN, I KNOW THAT THERE'S 

21 BEEN EDITORIALS AND THINGS LIKE THAT. THE ISSUE WAS NOT -- 

22 WE'VE HAD SOME COMPLAINTS ABOUT CLEANLINESS. BUT THE MAJORITY 

23 OF CALLS TO OUR OFFICE WAS THE ACTUAL OPERATING HOURS OF THE 

24 RESTROOMS THAT THEY'RE OPEN. SO WE NEED TO DEAL WITH THAT. AND 

25 WE CONTINUE TO NEED TO DEAL WITH THE ISSUE OF CLEANLINESS. AND 
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1 WE HAVE GOT TO BE ABLE TO FIX THAT WITHIN THE EXISTING 

2 RESOURCES OF WHAT YOU HAVE. I MEAN, YOU'RE GOING TO HAVE TO 

3 LOOK AT THE OTHER OPPORTUNITIES, WHETHER IT BE LIFEGUARDS ARE 

4 NOT AN ISSUE, BEACH CLEANLINESS IS NOT AN ISSUE, BECAUSE WE 

5 HAVE THE PUBLIC. AND IN THESE DAYS AND AGES, PEOPLE ARE USING 

6 OUR BEACHES MORE THAN EVER BECAUSE OF THE FREE ACCESS. AND SO 

7 IT'S IMPORTANT WE DEAL WITH IT. HOWEVER YOU CAN FIX THE 

8 PROBLEM YOU JUST HAVE TO FIX O IT. 

9

10 SANTOS KREIMANN: YEAH. WE COMPLETELY AGREE WITH THAT. AND I 

11 BELIEVE THAT THE PLAN THAT WE'VE WORKED WITH THE C.E.O.'S 

12 OFFICE, AS WELL AS THE DEPARTMENTS OF PARKS AND RECREATION 

13 HAVE BEEN A WONDERFUL HELP, AND LISA GARRET AND HER STAFF AT 

14 THE HUMAN RESOURCES DEPARTMENT HAVE BEEN VERY RESPONSIVE TO 

15 OUR CHALLENGE. AND SO WE COMPLETELY AGREE THAT HEALTH AND 

16 SAFETY OF THE PUBLIC IS PRIORITY ONE IN OUR DEPARTMENT. THAT 

17 IS THE REASON WE DID CHANGE THE SHIFT FROM 5 O'CLOCK, START 

18 TIME OF 5 O'CLOCK IN THE MORNING TO 7 O'CLOCK IN THE MORNING. 

19 NOW WE HAVE SOME HISTORY AND SOME EXPERIENCE UNDER OUR BELT. 

20 WE REALIZE THAT WE HAVE TO ADJUST OUR SCHEDULE, ADJUST OUR 

21 STAFFING. AND WE ALSO HAVE TO TAKE INTO CONSIDERATION THE FACT 

22 THAT WE NEED TO FIGURE OUT HOW TO OPEN UP THE FACILITIES UP 

23 EARLY IN THE MORNING. AND SO THAT'S WHAT WE'VE DONE. THE PLAN 

24 THAT WE HAVE IN PLACE OR THAT WE PRESENTED, WE'VE IMMEDIATELY 

25 TAKEN FOUR EMPLOYEES FROM OUR REGULAR SHIFT, MOVED THEM TO AN 
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1 EARLY MORNING SHIFT. WE'VE TRANSFERRED FOUR OTHER POSITIONS 

2 INTO THE EVENING SHIFT SO THAT WE COULD CLEAN THE RESTROOMS 

3 LATER ON IN THE EVENING AND LOCK THEM UP SO THAT THE SKELETON 

4 CREW CAN COME THROUGH IN THE MORNING AND OPEN UP THE MOST 

5 HEAVILY USED FACILITIES AT THAT PARTICULAR POINT IN TIME, 

6 WHICH WE BELIEVE WILL TAKE CARE OF THE ISSUE OF RESIDENTS THAT 

7 USE THE COASTLINE FOR RECREATIONAL PURPOSES AND EXERCISE 

8 PURPOSES, WILL TAKE CARE OF THEM EARLY IN THE MORNING. I WANT 

9 TO MAKE PERFECTLY CLEAR, NOT EVERY SINGLE RESTROOM FACILITY 

10 WILL BE OPENED AT 7 O'CLOCK IN THE MORNING. WE JUST DON'T HAVE 

11 THE STAFFING TO DO THAT. BUT THE MAJORITY OF THEM. AND WE'VE 

12 LOOKED AT THE COMPLAINTS, WHERE THEY'VE COME FROM, WE'VE 

13 IDENTIFIED THOSE RESTROOM FACILITIES THAT ABSOLUTELY NEED TO 

14 BE OPENED AS EARLY AS POSSIBLE, AND THAT'S THE PLAN THAT WE 

15 HAVE IN PLACE. WE ALSO HAVE A PLAN TO BRING ON 13 TEMPORARY 

16 EMPLOYEES TO HELP US THROUGH THE SUMMER SEASON. THOSE FOLKS 

17 WILL HELP BUTTRESS THE EVENING SHIFTS SO THAT MORE RESTROOM 

18 FACILITIES CAN BE CLEANED IN THE EVENING AND LOCKED UP SO THAT 

19 THEY COULD BE OPENED FIRST THING IN THE MORNING. SO OUR 

20 ULTIMATE GOAL IS TO TRY TO GET ALL 52 RESTROOM FACILITIES 

21 OPENED AS QUICKLY AS POSSIBLE. WE'RE HOPEFUL THAT WE CAN GET 

22 THEM OPEN BY 7 O'CLOCK IN THE MORNING, OR 8 O'CLOCK AT THE 

23 LATEST, BUT THAT'S THE CURRENT PLAN. IN TERMS OF FUNDING, 

24 WE'VE WORKED WITH THE C.E.O.'S OFFICE TO IDENTIFY SOME ONE-

25 TIME REVENUE. WE'RE GOING TO DEFER SOME HIRINGS ON OUR MARINA 
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1 SIDE OF THE SHOP. AND WE ARE GOING TO TAKE A SMALL REDUCTION 

2 IN THE MAINTENANCE BUDGET THAT WE HAVE WHICH WOULD REQUIRE US 

3 TO DEFER SOME ONGOING MAINTENANCE THAT WE WOULD NORMALLY TAKE 

4 CARE OF. 

5

6 SUP. ANTONOVICH, MAYOR: SUPERVISOR MOLINA? 

7

8 SUP. MOLINA: WELL SANTOS, I THANK YOU FOR THAT REPORT. I THINK 

9 YOU'RE DEALING WITH IT IN A REASONABLE FASHION. BUT I THINK 

10 THAT AGAIN, FOR US AS SUPERVISORS, WE'RE GOING TO HAVE TO GET 

11 ACCUSTOMED TO THE FACT THAT I KNOW THAT IN THE LAST THREE 

12 YEARS WE'VE ASKED THE DEPARTMENTS, SHAVE TWO PERCENT, SHAVE 

13 THREE PERCENT, SHAVE FIVE PERCENT. SO THAT MEANS THAT IT'S 

14 GOING TO EVENTUALLY HAVE AN IMPACT ON SERVICES, EVENTUALLY. 

15 NOW I KNOW THAT EVERYBODY CAN LOOK WITHIN THEIR BUDGET, AND 

16 THAT'S WHAT YOU'RE DOING AS I UNDERSTAND REMEDY THIS. BUT I 

17 ALSO THINK WE'D HAVE TO MAKE SURE THAT THE PUBLIC RECOGNIZES 

18 AND UNDERSTANDS THE DILEMMA THAT WE ARE IN FINANCIALLY. SO WE 

19 ARE GOING TO GET MORE COMPLAINTS. THAT DOESN'T MEAN THAT 

20 RESTROOMS HAVE TO BE DIRTY BECAUSE THAT DOES MEAN YOU HAVE TO 

21 REPRIORITIZE FROM WITHIN YOUR DEPARTMENT BUDGET. BUT I DO 

22 THINK THAT I HAVE A CONCERN WHEN YOU HAVE A SET OF RESIDENTS 

23 THAT LIVE BY THE BEACH AND THEY LIKE TO JOG AROUND THERE OR 

24 WHATEVER THEY DO. AND CHANGE OR DRIVE UP AND CHANGE THEIR 

25 CLOTHES AND ARE ACCUSTOMED TO BEING IN THERE BEFORE 7 O'CLOCK, 
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1 I DON'T KNOW THAT NECESSARILY WE CAN MEET ALL THOSE PERSONAL 

2 NEEDS. AND I'M HOPING THAT THAT'S NOT WHAT WE'RE DOING HERE. I 

3 UNDERSTAND THERE ARE NEEDS PEOPLE HAVE THAT MAY BE LIKE THAT. 

4 BUT I THINK WE HAVE TO FIND A WAY, AND THE PLAN THAT IS BEING 

5 PRESENTED SPEAKS MORE TO THE GENERAL PUBLIC, WHICH IS REALLY 

6 WHERE WE HAVE TO ADDRESS THESE ISSUES. SO I WANT US TO CREATE 

7 A BALANCE, BUT TO RECOGNIZE AND UNDERSTAND WE'RE ALL DEALING 

8 WITH ISSUES WHEN WE'RE CUTTING BACK. WE'VE BEEN CUTTING BACK 

9 ON LIGHTS IN SOME OF OUR PARKS WHEN YOU CAN'T HAVE THEM ON 

10 LATE AT NIGHT. WE HAVE FEES IN THOSE AREAS, AS WELL. AND WE 

11 HAVE BATHROOM ISSUES, AS WELL. SO I THINK THAT WE HAVE TO 

12 UNDERSTAND AND RECOGNIZE A BALANCE. SO LET'S NOT FORSAKE THAT, 

13 THAT ALL OF A SUDDEN WE HAVE SOME CRANKY JOGGER THAT LIKES 

14 JOGGING AT 6 O'CLOCK IN THE MORNING AND LIKES CHANGING IN OUR 

15 BATHROOM, MR. FUJIOKA, WANTS TO USE OUR PUBLIC FACILITIES AND 

16 WE'RE ALL GOING TO CHANGE AND ADJUST THE SCHEDULES 

17 ACCORDINGLY. I THINK WE HAVE TO LOOK AT A FAIR BALANCE AS TO 

18 HOW WE DO IT TO MAXIMIZE AND MEET THE NEEDS OF THE GENERAL 

19 PUBLIC. AND WE HAVE TO APOLOGIZE TO THOSE PEOPLE THAT WE CAN'T 

20 ACCOMMODATE FOR THEIR OWN PERSONAL NEEDS IF THAT IS THE 

21 SITUATION. I DON'T KNOW ALL THE DETAILS. BUT I THINK YOUR PLAN 

22 IS SOLID AND I THINK IT SHOULD BE FOCUSED ON THE HIGHEST NEED 

23 AND ADDRESS THOSE ISSUES. VERY, FRANKLY, THERE ARE SOME PEOPLE 

24 THAT GO TO THE BEACH AT 4, 5 OR 6 IN THE MORNING. BUT AT THE 

25 SAME TIME, THE GENERAL PUBLIC IS NOT THERE DURING THAT TIME 
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1 AND WE NEED TO MEET THOSE NEEDS OVERALL. SO I HATE TO SEE US 

2 FOCUSING AND READJUSTING OUR ENTIRE PLAN TO MEET THE NEEDS OF 

3 A COUPLE OF RESIDENTS THAT WOULD LIKE TO HAVE THAT SERVICE 

4 AVAILABLE. WE NEED TO LET THEM KNOW THE STATE IS CLOSING DOWN 

5 MAJOR STATE PARKS IN THIS STATE. I MEAN THIS ECONOMY IS HAVING 

6 AN IMPACT ON GOVERNMENT SERVICES. I'M ALL IN FAVOR OF LOOKING 

7 WITHIN OUR BUDGETS TO FIND THOSE WAYS. BUT EVERYONE HAS TO 

8 KNOW SOMETHING ELSE IS GOING TO SUFFER. I DON'T THINK IT'S 

9 FAIR FOR MR. FUJIOKA TO LOOK AT HIS BUDGET AS TO HOW TO 

10 ACCOMMODATE THESE NEEDS BECAUSE I HAVE A LIST OF THINGS THAT 

11 I'D LIKE HIM TO LOOK AT, TOO, THAT WE'VE TAKEN CUTBACKS ON IN 

12 OUR OWN LOCAL AREA. SO WITHIN YOUR BUDGET, FINE. ADJUSTMENT 

13 FOR A COUPLE OF RESIDENTS? NO. FOR THE GENERAL PUBLIC, A 

14 BALANCED PLAN, CLEAN REST ROOMS ARE A PRIORITY, I'M NOT GOING 

15 TO DISMISS THAT. BUT AT THE SAME TIME, YOU HAVE TO LOOK AT 

16 BALANCE. AND THESE ARE TOUGH TIMES. AND SO SERVICES ARE GOING 

17 TO SUFFER ALONG THE WAY, UNFORTUNATELY. THEY SHOULDN'T BE 

18 UNDER PUBLIC HEALTH NEEDS LIKE A RESTROOM. BUT THERE ARE GOING 

19 TO BE SOME CUTBACKS. AND WE ALL HAVE TO RECOGNIZE AND ALLOW 

20 OUR CUSTOMERS TO KNOW THAT IT'S NOT BUSINESS AS USUAL, 

21 UNFORTUNATELY. THESE ARE TOUGH TIMES. AND SO SOME ADJUSTMENTS 

22 WILL HAVE TO BE MADE. SO I JUST WANT TO MAKE SURE THAT WE 

23 UNDERSTAND IT WITHIN THAT FRAMEWORK. 

24

25 SANTOS KREIMANN: THANK YOU. 
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1

2 SUP. ANTONOVICH, MAYOR: OKAY. THANK YOU. APPROVE MOTION BY 

3 SUPERVISOR KNABE. SECONDED WITHOUT OBJECTION, SO ORDERED. 

4

5 CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, 

6 NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL 

7 CONVENE IN CLOSED SESSION TO DISCUSS ITEM NO. CS-1, CONFERENCE 

8 WITH LEGAL COUNSEL REGARDING SIGNIFICANT EXPOSURE TO 

9 LITIGATION, ONE CASE. ITEM NO. CS-2, PUBLIC EMPLOYMENT 

10 CONSIDERATION OF CANDIDATES FOR THE POSITION OF SUPERINTENDENT 

11 OF SCHOOLS FOR THE LOS ANGELES COUNTY OFFICE OF EDUCATION AND 

12 ITEM NO. CS-3, DEPARTMENT HEAD PERFORMANCE EVALUATIONS AS 

13 INDICATED ON THE POSTED AND SUPPLEMENTAL AGENDAS. THANK YOU. 

14

15

16

17

18

19

20

21

22

23

24

25
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1 REPORT OF ACTION TAKEN IN CLOSED SESSION JUNE 7, 2011

2

3

4

5 No reportable action was taken on items CS-1 or CS-3. 

6

7 CS-2. PUBLIC EMPLOYMENT (Government Code Section 54957) 

8 Consideration of candidates for the position of Superintendent 

9 of Schools for the Los Angeles County Office of Education. 

10 (10-2348) 

11

12 The Board appointed Arturo Delgado to the position of County 

13 Superintendent of Schools effective July 1, 2011, and 

14 instructed the Director of Personnel to prepare an at-will 

15 employment contract which is approved as to form by the County 

16 Counsel. 

17

18 The vote of the Board was unanimous with all Supervisors being 

19 present. 

20

21

22

23

24

25



June 7, 2011

72

1 I, JENNIFER A. HINES, Certified Shorthand Reporter Number 

2 6029/RPR/CRR qualified in and for the State of California, do 

3 hereby certify:

4      That the transcripts of proceedings recorded by the Los 

5 Angeles County Board of Supervisors June 7, 2011,

6 were thereafter transcribed into typewriting under my 

7 direction and supervision;

8      That the transcript of recorded proceedings as archived 

9 in the office of the reporter and which have been provided to 

10 the Los Angeles County Board of Supervisors as certified by 

11 me.

12      I further certify that I am neither counsel for, nor 

13 related to any party to the said action; nor

14 in anywise interested in the outcome thereof.

15      IN WITNESS WHEREOF, I have hereunto set my hand this 

16 13th day of June 2011, for the County records to be used only 

17 for authentication purposes of duly certified transcripts      

18 as on file of the office of the reporter.

19   
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21              CSR No. 6029/RPR/CRR

22


	Adobe Acrobat Reader
	Finding Words


